Copyright

© Copyright 2016 SAP AG. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

Microsoft, Windows, Excel, Outlook, and PowerPoint are registered trademarks of Microsoft Corporation.

IBM, DB2, DB2 Universal Database, System i, System i5, System p, System p5, System z, System z10, System z9, z10, z9, iSeries, pSeries, xSeries, zSeries, eServer, z/VM, z/OS, i5/OS, S/390, OS/390, OS/400, AS/400, S/390 Parallel Enterprise Server, PowerVM, Power Architecture, POWER6+, POWER6, POWER5+, POWER5, POWER, OpenPower, PowerPC, BatchPipes, BladeCenter, System Storage, GPFS, HACMP, RETAIN, DB2 Connect, RACF, Redbooks, OS/2, Parallel Sysplex, MVS/ESA, AIX, Intelligent Miner, WebSphere, Netfinity, Tivoli and Informix are trademarks or registered trademarks of IBM Corporation.

Linux is the registered trademark of Linus Torvalds in the U.S. and other countries.

Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either trademarks or registered trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Oracle is a registered trademark of Oracle Corporation.

UNIX, X/Open, OSF/1, and Motif are registered trademarks of the Open Group.

Citrix, ICA, Program Neighborhood, MetaFrame, WinFrame, VideoFrame, and MultiWin are trademarks or registered trademarks of Citrix Systems, Inc.

HTML, XML, XHTML and W3C are trademarks or registered trademarks of W3C®, World Wide Web Consortium, Massachusetts Institute of Technology.

Java is a registered trademark of Sun Microsystems, Inc

JavaScript is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by Netscape.

SAP, R/3, xApps, xApp, SAP NetWeaver, Duet, PartnerEdge, ByDesign, SAP Business ByDesign, and other SAP products and services mentioned herein as well as their respective logos are trademarks or registered trademarks of SAP AG in Germany and in several other countries all over the world. All other product and service names mentioned are the trademarks of their respective companies. Data contained in this document serves informational purposes only. National product specifications may vary.

These materials are subject to change without notice. These materials are provided by SAP AG and its affiliated companies ("SAP Group") for informational purposes only, without representation or warranty of any kind, and SAP Group shall not be liable for errors or omissions with respect to the materials. The only warranties for SAP Group products and services are those that are set forth in the express warranty statements accompanying such products and services, if any. Nothing herein should be construed as constituting an additional warranty.
Terms for Included Open Source Software

This SAP software contains also the third party open source software products listed below. Please note that for these third party products the following special terms and conditions shall apply.

SAP License Agreement for STLport

SAP License Agreement for STLport
between
SAP Aktiengesellschaft
Systems, Applications, Products in Data Processing
Neuottstrasse 16
69190 Walldorf
Germany
( hereinafter: SAP )

and

you
( hereinafter: Customer )

1. Subject Matter of the Agreement
   a. SAP grants Customer a non-exclusive, non-transferable, royalty-free license to use the STLport.org C++ library (STLport) and its documentation without fee.
   b. By downloading, using, or copying STLport or any portion thereof Customer agrees to abide by the intellectual property laws, and to all of the terms and conditions of this Agreement.
   c. The Customer may distribute binaries compiled with STLport (whether original or modified) without any royalties or restrictions.
   d. Customer shall maintain the following copyright and permission notices on STLport sources and its documentation unchanged:
      Copyright 2001 SAP AG
   e. The Customer may distribute original or modified STLport sources, provided that:
      - The conditions indicated in the above permission notice are met;
      - The following copyright notices are retained when present, and conditions provided in accompanying permission notices are met:

      Copyright 1994 Hewlett-Packard Company
      Copyright 1997 Moscow Center for SPARC Technology.
      Copyright 1999,2000 Boris Fomitchev
      Copyright 2001 SAP AG

      Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Hewlett-Packard Company makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.
Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Silicon Graphics makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Moscow Center for SPARC Technology makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

Boris Fomitchev makes no representations about the suitability of this software for any purpose. This material is provided "as is", with absolutely no warranty expressed or implied. Any use is at your own risk. Permission to use or copy this software for any purpose is hereby granted without fee, provided the above notices are retained on all copies. Permission to modify the code and to distribute modified code is granted, provided the above notices are retained, and a notice that the code was modified is included with the above copyright notice.

Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. SAP makes no representations about the suitability of this software for any purpose. It is provided with a limited warranty and liability as set forth in the License Agreement distributed with this copy. SAP offers this liability and warranty obligations only towards its customers and only referring to its modifications.

2. **Support and Maintenance**
   SAP does not provide software maintenance for the STLport. Software maintenance of the STLport therefore shall be not included.

   All other services shall be charged according to the rates for services quoted in the SAP List of Prices and Conditions and shall be subject to a separate contract.

3. **Exclusion of warranty**
   As the STLport is transferred to the Customer on a loan basis and free of charge, SAP cannot guarantee that the STLport is error-free, without material defects or suitable for a specific application under third-party rights. Technical data, sales brochures, advertising text and quality descriptions produced by SAP do not indicate any assurance of particular attributes.

4. **Limited Liability**
   a. Irrespective of the legal reasons, SAP shall only be liable for damage, including unauthorized operation, if this (i) can be compensated under the Product Liability Act or (ii) if caused due to gross negligence or intent by SAP or (iii) if based on the failure of a guaranteed attribute.
   b. If SAP is liable for gross negligence or intent caused by employees who are neither agents or managerial employees of SAP, the total liability for such damage and a maximum limit on the scope of any such damage shall depend on the extent to which its occurrence ought to have anticipated by SAP when concluding the contract, due to the circumstances known to it at that point in time representing a typical transfer of the software.
   c. In the case of Art. 4.2 above, SAP shall not be liable for indirect damage, consequential damage caused by a defect or lost profit.
d. SAP and the Customer agree that the typical foreseeable extent of damage shall under no circumstances exceed EUR 5,000.

e. The Customer shall take adequate measures for the protection of data and programs, in particular by making backup copies at the minimum intervals recommended by SAP. SAP shall not be liable for the loss of data and its recovery, notwithstanding the other limitations of the present Art. 4 if this loss could have been avoided by observing this obligation.

f. The exclusion or the limitation of claims in accordance with the present Art. 4 includes claims against employees or agents of SAP.

**Icons in Body Text**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🚨</td>
<td>Caution</td>
</tr>
<tr>
<td>🌟</td>
<td>Example</td>
</tr>
<tr>
<td>🔴</td>
<td>Note</td>
</tr>
<tr>
<td>📌</td>
<td>Recommendation</td>
</tr>
<tr>
<td>🔗</td>
<td>Syntax</td>
</tr>
</tbody>
</table>

Additional icons are used in SAP Library documentation to help you identify different types of information at a glance. For more information, see Help on Help → General Information Classes and Information Classes for Business Information Warehouse on the first page of any version of SAP Library.

**Typographic Conventions**

<table>
<thead>
<tr>
<th>Type Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Example text</em></td>
<td>Words or characters quoted from the screen. These include field names, screen titles, pushbuttons labels, menu names, menu paths, and menu options. Cross-references to other documentation.</td>
</tr>
<tr>
<td><strong>Example text</strong></td>
<td>Emphasized words or phrases in body text, graphic titles, and table titles.</td>
</tr>
<tr>
<td>EXAMPLE TEXT</td>
<td>Technical names of system objects. These include report names, program names, transaction codes, table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE.</td>
</tr>
<tr>
<td><em>Example text</em></td>
<td>Output on the screen. This includes file and directory names and their paths, messages, names of variables and parameters, source text, and names of installation, upgrade and database tools.</td>
</tr>
<tr>
<td><strong>Example text</strong></td>
<td>Exact user entry. These are words or characters that you enter in the system exactly as they appear in the documentation.</td>
</tr>
<tr>
<td><em>&lt;Example text&gt;</em></td>
<td>Variable user entry. Angle brackets indicate that you replace these words and characters with appropriate entries to make entries in the system.</td>
</tr>
<tr>
<td>EXAMPLE TEXT</td>
<td>Keys on the keyboard, for example, F2 or ENTER.</td>
</tr>
</tbody>
</table>
4.6.6 Creating and Deploying Self-Installing Packages ........................................... 40
4.7 Patching the Installation Server ........................................................................... 42
4.8 Configuring Local Security Handling .................................................................. 43
4.9 Configuring SAP Automatic Workstation Update ............................................... 44
4.10 Controlling Remote Workstations .................................................................... 46

5. Installation Process ............................................................................................... 47

5.1 Installation of the SAP Front End .......................................................................... 47
  5.1.1 Installing Components from an Installation Server ......................................... 48
    5.1.1.1 Installing Packages Configured by the Administrator .............................. 50
    5.1.1.2 Installing Packages Using the Logon Script ........................................... 51
  5.1.2 Installing Components Locally from a Distribution Medium .......................... 52
5.2 Update of the SAP Front End .............................................................................. 54
  5.2.1 Updating the Front End from an Installation Server .................................... 54
  5.2.2 Patching a Standalone Front End .................................................................. 55

6 Additional Information ............................................................................................ 56

6.1 Removing an Installation Server .......................................................................... 56
6.2 Uninstalling the SAP Front End .......................................................................... 57
6.3 FAQs .................................................................................................................... 57
6.4 Diagnosing Front-End Software Installations using NWCheckWorkstation .......... 57
6.5 Repairing Front-End Software Installations using NWSAPSetup .......................... 58
6.6 Viewing Log and Error Files ............................................................................... 58
6.7 Command-Line Parameters .................................................................................. 59
6.8 Return Codes ....................................................................................................... 62
6.9 Component List ................................................................................................... 63
6.10 SAP UI Landscape Format XML Description .................................................... 70
SAP Front End Installation Guide

Purpose
This documentation describes how to install and distribute the SAP front-end software on Windows.

The document contains the following sub-sections:

Introduction [page 9]
Planning [page 13]
Preparation [page 30]
Installation Process [page 47]
Additional Information [page 56]

1 Introduction

Scope of this Document
The SAP GUI family consists of:

- SAP GUI for Windows
  This GUI is described in detail here.

- SAP GUI for Java
  SAP GUI for Java is a generic SAP GUI that runs on a variety of platforms including Windows, Mac OS X, Linux, and UNIX platforms. It has the same look and feel as the Windows version with the exception of the platform-specific window design.
  **This GUI is not described here.** Instead, you can find documentation describing the installation of SAP GUI for Java in either of the following places:
  - In the folder PRES2/GUI/DOC on the SAP NetWeaver Presentation DVD.
  - On SDN under:
    http://scn.sap.com/docs/DOC-25456 → Installation → SAP GUI for Java
    The installation instructions for SAP GUI for the Java environment are in chapter 4 of the document PlatinManual.

- SAP GUI for HTML
  SAP GUI for HTML is based on the SAP Internet Transaction Server (ITS), which is fully integrated into the kernel of the SAP Web Application Server. On the desktop, a suitable browser and a Java Runtime are fully sufficient for running SAP GUI for HTML.
  **This GUI is not described here** since the SAP GUI for HTML does not need SAP software to be deployed on the client.

SAP GUI for HTML and SAP GUI for Java do **not** have all the capabilities of SAP GUI for Windows. Some applications such as SAP BI or SAP SCM require the SAP GUI for Windows.

More information: Master Guides for the relevant SAP products

More information about the SAP GUI family: http://scn.sap.com/docs/DOC-25456
Platforms

You can find information on SAP GUI for Windows platform support in the SAP Product Availability Matrix at [https://service.sap.com/pam](https://service.sap.com/pam) or in SAP note 66971.

Compatibility

SAP GUI for Windows 7.40 cannot be run on Windows XP and Windows 2003 Server. If you still want to use these platforms, you can use SAP GUI for Windows 7.30 until its end of maintenance (see note 147519).

SAP GUI for Windows 7.40 is compatible with all SAP products based on SAP NetWeaver 7.40 and all earlier releases of SAP software that are still supported by SAP.

Only one version of SAP GUI is possible.

SAP GUI for Windows uses the Microsoft Controls technology, which means that all controls are registered locally during the installation. As a result, the system database contains an entry indicating where each control can be found. Since the system always registers the latest controls, only the most recently installed version of a control is available at any time.

This means that on a single computer only one version of SAP GUI for Windows can be installed. During installation of a new SAP GUI release, any older SAP GUI release present on the computer is uninstalled. However, SAP GUI for Windows supports virtualization products which can be used to run multiple SAP GUI versions on the same client in parallel if needed; for details see SAP note 66971.

1.1 New or Changed Features in SAP GUI for Windows 7.40

The following overview shows the new or changed features of the compilations starting with the latest one:

Compilation 2

- **New component** SAP 3D Visual Enterprise Viewer 8.0 SP3 MP1

Visual Enterprise Viewer (VEV) is a free 3D visualisation viewer for Windows. VEV allows collaboration, analytics, as well as assembly and maintenance work instructions to be delivered in interactive real-time 3D.

Compilation 1

- With compilation 1, a new configuration file format is available called SAP UI Landscape. The use of the file format is optional, except for the installation with SAP NetWeaver Business Client (NWBC). Then you need to use it. The new file format simplifies the configuration by unifying the persisted connection and connection configuration data from SAP GUI for Windows, SAP GUI for Java and NWBC in a modern and easy way:
  - There are less configuration files involved and they are stored in the same directory.
  - Configuration files can either be stored locally or on a central server or share.
  - Deployment options “pull” and “push” are available.
  - The configuration files are the same for SAP GUI for Windows, SAP GUI for Java and NWBC.
  - If SAP GUI has been used already, the connection data will be migrated automatically into the SAP UI Landscape format.
This format will be activated either when setting the corresponding registry key or automatically when NWBC 5.0 is installed together with SAP GUI for Windows 7.40.

You find more information under 2. Configuration Information.

- **As of SAP NetWeaver Business Client (NWBC) 5.0, which is delivered on the SAP GUI DVD, SAP GUI for Windows can be embedded into the NWBC**, so that the user has one shell that unifies multiple frontends. One desktop/taskbar icon consolidates NWBC and SAP GUI sessions, tasks, frequently used links etc. in a tabbed view NWBC frame.

For the integration, you simply install SAP GUI for Windows 7.40 together with the SAP NetWeaver Business Client (NWBC) 5.0.

- **New component** Install SAP GUI Desktop Icon / Shortcuts even though NWBC is installed

  When SAP GUI for Windows 7.40 is installed together with SAP NetWeaver Business Client (NWBC), by default, SAP GUI and SAP GUI Shortcuts will be launched through NWBC. However, when you want to use SAP GUI and NWBC in parallel, you can select this component to install the SAP Logon (Pad) Desktop Icon and to register SAP GUI shortcuts to SAP Logon.

- **Setting registry keys on package level** is now possible, see also 4.6.2 Configuring Packages and Scripting Events.

- **SAP Screenreader Extensions** are now part of the SAP GUI for Windows installation, see note 1139953.

  SAP GUI Screen Reader Extensions (SRX) enable the use of SAP GUI together with the screen reader program Jaws for Windows. The Extensions are Jaws-based scripts that make the SAP GUI accessible via the SAP GUI object model.

  SRX will still be seperately patched via the SAP Service Marketplace. You find the patches under http://service.sap.com/patches -> SAP Frontend Components (which you can find, for example, via Browse our Download Catalog -> SAP Screenreader Extensions -> SAP Screen Reader Extensions).

  ![Recommendation](image)

  The administrator should add SRX to the installation packages for visually impaired users who use JAWS. Other users should not get SRX, because it can only be installed, if JAWS is used.

- **A new version of the SAP Calendar Synchronization for Microsoft Outlook** is delivered with SAP GUI 7.40 for Windows. This version can be used with Outlook 2010.

- **As of Java release 8 (1.8), the AxBridge is no longer supported by Java**, so that the implementation of the embedding of JNet/JGantt in SAP GUI for Windows had to be changed. With Java 8, the HTML-Control is used which is part of the SAP GUI and in which JNet/JGantt are instantiated as Java applets. For details and restrictions, see note 2103687.

- **New caching options** when having installed SAP GUI with SAP NetWeaver Business Client: When using one option, the cache is updated with every SAP Logon (Pad) start. When using the other, the server is only contacted, if the last enquiry or download took place more than x hours ago. This saves long roundtrips in slow networks. For details, see 2.2.6 Caching Server Configuration Files.

### 1.2 Deleted Features

The following components have been removed with SAP GUI 7.40 compilation 2:

- **ECL Viewer**
The viewer provides functions such as Redlining/Markup, Comparing, Measurement, Stamps and Watermarks, Rotating, Zooming and Printing. See SAP Note 2155818 for more information about the removal. If an application is trying to use the ECL Viewer and this component is not installed, an error "Error while calling the EAI Viewer" is displayed in SAP GUI.

- Controls for the SAPscript Legacy Text Editor

  If this component is not installed an error "CSapEditorCtrl::GetObject: Object 15 does not exist" is displayed, when trying to edit SAPscript documents with the SAPscript editor. See SAP Note 2155818 for more information about the removal. And see SAP Note 742662 for more information on the alternative Microsoft Word-based editing for SAPscript.

The following components have been removed with SAP GUI 7.40 compilation 1:

- 'FI-LC: Remote Data Entry' and 'EC-CS: Remote Data Entry'
  For more information, see note 169887.
- Standard Regression Testing (START)
  For more information, see note 2045115.

1.3 SAP Notes for the Installation

You must read the following SAP notes before you start the installation. These SAP notes contain the most recent information about the installation, as well as corrections to the installation documentation.

Make sure that you have the up-to-date version of each SAP note, which you can find on SAP Service Marketplace at https://service.sap.com/notes.

**SAP notes for the Installation**

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>456905</td>
<td>Composite SAP note about SAPSetup as of Release 6.20. Lists the SAP notes relevant for the installation of SAP GUI for Windows.</td>
</tr>
<tr>
<td>26417</td>
<td>Latest information about hardware and software requirements of SAP GUI for Windows</td>
</tr>
<tr>
<td>66971</td>
<td>Latest information about supported front-end platforms</td>
</tr>
<tr>
<td>147519</td>
<td>Latest information about release and maintenance strategy of SAP GUI.</td>
</tr>
<tr>
<td>166130</td>
<td>Latest information about delivery and compatibility of the components delivered on the SAP NetWeaver Presentation DVD.</td>
</tr>
<tr>
<td>1587566</td>
<td>Lists the known problems concerning SAPSetup.</td>
</tr>
</tbody>
</table>
1.4 Information Available on SAP Service Marketplace

**Installation of the SAP GUI for Windows**

Latest version of this document: SAP Service Marketplace at [https://service.sap.com/instguidesNW](https://service.sap.com/instguidesNW)

**Installation of the SAP GUI for Java**


**Installation of the SAP Online Documentation**

You can access the SAP online documentation from the front end. The installation of the SAP online documentation is described in the document **Installing the SAP Library** on SAP Service Marketplace at [https://service.sap.com/instguidesNW → Other Documentation → SAP Library](https://service.sap.com/instguidesNW → Other Documentation → SAP Library).

**SAP GUI Family**


**Supported Platforms**

Information about the platforms on which you can run SAP GUI: SAP Product Availability Matrix at [https://service.sap.com/pam](https://service.sap.com/pam) or [SAP note 66971](https://service.sap.com/pam).

1.5 Naming Conventions

“Upgrade” means the transition from one release to another, for example, from 7.30 to 7.40. “Update” means a change within the same release. You use a “patch” to apply the update.
2. Configuration Information

With the release of the new SAP UI Landscape file format, you have the choice between two possible SAP GUI configuration scenarios:

- **Configuration without SAP UI Landscape format**
  'Classic' installation procedure.

- **Installation with SAP UI Landscape format**

  Note that the installation with SAP NetWeaver Business Client (NWBC) only works with this file format. In this case, SAP UI Landscape is used automatically. Otherwise it is optional.

The new file format simplifies the configuration by unifying the persisted connection and connection configuration data from SAP GUI for Windows, SAP GUI for Java and NWBC in a modern and easy way:

- There are less configuration files involved and they are stored in the same directory.
- Configuration files can either be stored locally or on a central server or share.
- Deployment options "pull" and "push" are available.
- The configuration files are the same for SAP GUI for Windows, SAP GUI for Java and NWBC.
- If SAP GUI has been used already, the connection data will be migrated automatically into the SAP UI Landscape format.

This format will be activated when setting the corresponding registry key LandscapeFormatEnabled (for details, see the administration guide) or, automatically, when NWBC 5.0 is installed together with SAP GUI for Windows 7.40.

In the following subchapters, you find an overview of the configuration files, the configuration scenarios and the configuration file provision for the installation without and with SAP UI Landscape.

### 2.1 Configuration without SAP UI Landscape

The configuration without SAP UI landscape format is quite different from the installation with SAP UI Landscape. There are more files involved and they are stored in different paths. The installation without SAP UI Landscape is explained in the following subchapters. Details on the installation with SAP UI Landscape are explained in chapter 2.2 Configuration with SAP UI Landscape.

The long-term goal is to replace this conventional configuration option by the newer one used in the Configuration with SAP UI Landscape. To offer both options is just an interim solution.

### 2.1.1 Configuration Files Overview

In the configuration without SAP UI Landscape, SAP GUI for Windows, SAP GUI for Java and SAP GUI for HTML use their own configuration files.

In the installation and configuration scenario without SAP UI Landscape, there are some files that have to be deployed to each client (push mechanism) and some that can be used...
centrally and locally. You find a list of configuration files belonging to each group in the following overview:

**Local Files**

**sapmsg.ini**

| Content | IP names or addresses of existing message servers  
|         | Message server descriptions  
|         | Ports: The ports of the message servers can also be entered here (see note 1608939). This replaces the port entries in the services file. A further alternative is to use the saplogon.ini (see saplogon details below). |

| Purpose | Creation of a new message server entry in SAP Logon (not SAP Logon Pad). |
| Path    | %WINDIR% |
| Who fills the file | The file is filled by the administrator and must be deployed to each client. This file is changed, when a new system is added or an existing one is moved. The notation is as follows: <system>=<message server> and <system>=<message server description> |

**saproute.ini**

| Content | List of available SAP routers including address and port in the following notation: /H/<Address>/S/<Port>/H/  
|         | Default router that is preselected when a new entry is created in SAP Logon. |

| Purpose | Creation of a router entry in SAP Logon (not SAP Logon Pad). SAP routers are, for example, necessary, if a firewall has to be passed. |
| Path    | %WINDIR% |
| Who fills the file | The file is filled by the administrator and rarely needs an update. It must be deployed to each client, if routers are used. |

**services**

| Content | Note that this file contains the local ports and is operation system-specific and should not be deleted! Thus, the SAP port entries have to be merged with the original file. Each entry has to end with a line feed.  
|         | Ports for the communication with application servers – written by NWSAPSAPSetup.  
|         | Port list of the available message servers (one port per server) |

The ports of the message servers can also be entered in the sapmsg.ini file (see note 1608939). This replaces the port entries in this services file. A further alternative is to
use the saplogon.ini (see saplogon details below).

<table>
<thead>
<tr>
<th>Purpose</th>
<th>The information contained in this file is used to communicate directly with an SAP system via the application server (with sapdp ports) or indirectly via message servers for load balance reasons (with information of the sapmsg.ini and the services file).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path</td>
<td>Operating system file under <code>%WINDIR%\System32\drivers\etc</code></td>
</tr>
<tr>
<td>Who fills the file</td>
<td>The file is filled by the administrator and has to be deployed to the clients. This file is changed, when a new system is added or an existing one is moved.</td>
</tr>
</tbody>
</table>

**Local and Central Files**

The following files can be pushed to local clients or pulled from a central storage on an http server or share.

**saplogon.ini**

<table>
<thead>
<tr>
<th>Content</th>
<th>saplogon.ini contains information about the connection entries in SAP Logon (Pad). The host name for message servers and ports can also be maintained in this file (see note <a href="#">1685221</a>). In this case, the distribution of the services and sapmsg.ini files is not necessary.</th>
</tr>
</thead>
</table>
| Purpose | • SAP Logon (Pad) reads the entries for the connections section from this file.  
• The connection entries are configured here: system, Name, SNC (on / off), server…  
• Setting of options for SAP Logon |
| Path    | Locally: `%APPDATA%\SAP\Common`  
Centrally: Registry entry for ConfigFileOnServer. You find information on the registry keys in the SAP GUI for Windows administration guide. |
| Who fills the file | The file can be made available centrally by the admin or with push by the administrator. In addition, the users can create own entries. For file creation, SAP Logon can be used. |

**sapshortcut.ini**

| Content | Contains information about the SAP shortcut entries in SAP Logon (Pad):  
• Name of the entry shown at start  
• Configuration of the shortcut |
|---------|-------------------------------------------------------------------------------------------------------------------------------------------------------------------|
| Purpose | • SAP Logon (Pad) reads from this file the entries for the shortcuts section.  
• The shortcut entries are configured here: system, name, command |
### Saplogontree.xml

<table>
<thead>
<tr>
<th>Content</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saplogontree.xml references entries in ini.files</td>
<td>• References other configuration files.</td>
</tr>
<tr>
<td></td>
<td>• Contains the SAP Logon folders and assigns a folder to each entry.</td>
</tr>
<tr>
<td></td>
<td>• References the connection entries of saplogon.ini</td>
</tr>
<tr>
<td>Purpose</td>
<td>Persists the folder structure of SAP Logon as well as the comments.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Path</th>
<th>Locally: <code>%APPDATA%\SAP\Common</code></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Centrally: Registry entry for ConfigFileOnServer. You find information on the registry keys in the SAP GUI for Windows administration guide.</td>
</tr>
</tbody>
</table>

| Who fills the file                                                         | This file is typically filled by the user and contains combinations of system and application. These can be started by an action. The tool to create this file is SAP Logon itself. |

### 2.1.2 Configuration File Storage

The storage of the `saplogon.ini` and `sapshortcut.ini` files has been changed as of SAP GUI for Windows 720 (see also [Application Data Directories](#)).

The storage of other SAP Logon configuration files like `sapmsg.ini`, `saproute.ini` and service files has been kept the same as in the older SAP GUI releases (for details refer to [note 38119](#)), because these files are not only used by SAP GUI, but also by other SAP components. Therefore, no changes have been made concerning the storage of these files as of SAP GUI 720.

With SAP GUI 7.20, the `saplogon.ini` and `sapshortcut.ini` files are stored in the roaming user application directory. The default of this path is the `SAP\Common` directory:

```
%APPDATA%\SAP\Common
```

%APPDATA% stands for the environment variable specifying the application data directory located directly below the user profile directory.

The paths for Windows XP/Vista/7 is as follows:

```
%APPDATA%\Roaming\SAP\Common
```

The file creation process depends on whether you install SAP GUI for the first time or if you do an upgrade:
• If you install SAP GUI for Windows ≥ 7.20 the first time on a client:
  After having installed SAP GUI, you start SAP Logon for the first time. The saplogon.ini file will be automatically created in the Common directory mentioned above. Use SAP Logon to create the necessary entries. Your configuration will be saved in the corresponding newly created configuration file(s).

• If you upgrade an existing SAP GUI for Windows to release ≥ 7.20:
  After having upgraded the SAP GUI, you start SAP Logon for the first time. SAP Logon will now search for the default saplogon.ini and sapshortcut.ini files used in the former SAP Logon release in the known locations: the SAP GUI installation or the Windows directory.
  SAP Logon will then copy the existing saplogon.ini and sapshortcut.ini files to the Common folder, so that the former configuration details can be used again with the upgraded SAP GUI. The old versions of the *.ini files used with previous SAP GUI releases will remain in the former locations to allow going back to older SAP GUI releases, if this should ever be required. However, note that entries you added in SAP Logon as of SAP GUI for Windows 7.20 will not be added to the *.ini files in the old locations.

  SAP Logon will copy the existing saplogon.ini and sapshortcut.ini files to the Common folder only, when the file to be copied (in the SAP GUI installation or the Windows directory) is not defined as the server file. See section Creating and Distributing Server Configuration Files.

In both cases, the next time you start SAP Logon or SAP LogonPad, the Common folder provides the necessary configuration information.

If necessary, you can change the default directory paths using the Options dialog in SAP Logon. You find the necessary options under SAP Logon Options -> Configuration Files. There, also the path of your local configuration files and the names and content of the loaded local configuration files are displayed.

You can still use the command line parameter /INI_FILE= or environment variable SAPLOGON_INI_FILE to make your own saplogon.ini file to be used by SAP Logon (Pad) as in the former SAP GUI for Windows releases (see the related note 38119).

The searching order of the saplogon.ini file in SAP GUI for Windows as of release 7.20 is as follows:

1. File name from command line parameter /INI_FILE=
2. File name from environment variable SAPLOGON_INI_FILE
3. saplogon.ini under Path of Local Configuration Files shown in the SAP Logon Configuration Files dialog
4. saplogon.ini in the SAP GUI installation directory
5. saplogon.ini in the Windows directory

4. and 5. will only be considered at the first start of SAP Logon (Pad), if no saplogon.ini file is yet existing under Path of Local Configuration Files described in bullet 3. And the file found will be copied to the path of local configuration files for next SAP Logon (Pad) start.
The sapshortcut.ini file is always stored in the same directory as the saplogon.ini. Additionally, a new configuration file SapLogonTree.xml will be created in the same directory as the saplogon.ini in order to store the tree (folder) structure defined in SAP Logon.

If the SapLogonTree.xml is in the same path as your input saplogon.ini file and you use command line parameter /INI_FILE= or environment variable SAPLOGON_INI_FILE to start SAP Logon (Pad), the tree (folder) structure defined in this SapLogonTree.xml will be used. Otherwise, a new SapLogonTree.xml will be created in the same path as the saplogon.ini and sapshortcut.ini files used in SAP Logon. Any folder configuration in the running SAP Logon will be saved in this SapLogonTree.xml file.

In SAP Logon Pad, no configuration is possible and, therefore, no configuration files will/should be modified in this path. If SapLogonTree.xml is not existing and cannot be created due to, for example, authorization issues, no tree structure can be displayed in SAP Logon (PAD). An error message box will be shown and SAP Logon (Pad) will be terminated.

- The value for command line parameter /INI_FILE= or environment variable SAPLOGON_INI_FILE should contain a full path and a file name, as for example, /INI_FILE=C:\temp\saplogon1.ini.
- If different saplogon (SAPShortcut) *.ini files are to be used, the ini files should be stored in different folders due to the configuration file SapLogonTree.xml. For example,

  /INI_FILE=C:\temp\config1\saplogon1.ini

  and

  /INI_FILE=C:\temp\config2\saplogon2.ini

  This way, the corresponding SapLogonTree.xml files can be created respectively.

In this example, SapLogonTree.xml in folder C:\temp\config1 corresponds to C:\temp\config1\saplogon1.ini and SapLogonTree.xml in folder C:\temp\config2 corresponds to C:\temp\config2\saplogon2.ini.

### 2.1.3 Creating and Distributing Configuration Files

This section describes, how you can provide SAP Logon server configuration files for your users.

#### Procedure

Proceed as follows to create and distribute the server configuration file(s):

1. Start SAP Logon with parameter /INI_FILE=[Path][name], for example:

   saplogon.exe /INI_FILE=N:\740\test\ saplogon.ini

   or

   saplogon.exe /INI_FILE=\Servername\CSN\2012\740\test\ saplogon.ini

   where [Path] is the place for saplogon.exe to create and save the server (central) configuration files for your users, like SapLogonTree.xml, saplogon.ini and sapshortcut.ini.

   The files saplogon.ini and sapshortcut.ini can be old ini files you used in a former SAP GUI version. If they are missing before starting SAP Logon, they will be created by SAP Logon. The SapLogonTree.xml file will also be created. If it is already existing, for example, in case you restart SAP Logon, it will be reused.
2. After the SAP Logon window appears, add folders and entries as needed.

3. Close all SAP GUI windows including SAP Logon (Pad).

   The configuration files *.xml and *.ini under the folder given by the /INI_FILE= parameter are ready to be used by your users as server configuration files.

4. If the users start SAP Logon (Pad) with /INI_FILE= command parameter or environment variable SAPLOGON_INI_FILE as in the older SAP GUI releases (see note 38119), only these central files will be used as so far.

5. Your users can also use both the server and their own local configuration files together. This can be configured in the following ways:
   
a. You create the registry key ConfigFileOnServer for your users on their local machines as follows (note that the same key value ConfigFileOnServer under current user HKCU must be deleted if existing):

```
HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAPLogon\Options (32 bits)
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\SAPLogon\Options) (64 bits)
"ConfigFileOnServer" ( REG_EXPAND_SZ) with server file name as value data, for example, \[Servername]\CSN:2009\720\test\SapLogonTree.xml.
(The string can also contain unexpanded references to environment variables like %PATH%).
```

b. Or you let your users run saplogon.exe, open SAP Logon option dialog, and input the XML file name with the full path in the field XML Configuration File on Server in the Configuration Files dialog. The setting will be written to the Windows registry as Expandable String Value "ConfigFileOnServer" under current user HKCU:

```
HKEY_CURRENT_USER\Software\SAP\SAPLogon\Options

For SAP Logon (saplogon.exe), the setting under HKCU has higher priority.
For SAP Logon Pad (saplgpad.exe), the setting under HKLM has higher priority.
```

After that, your users can start SAP Logon by clicking the installed SAP Logon icon on the desktop.

The folders and entries defined on the server side will be shown together with the local configuration.

6. In all cases, you still distribute the sapmsg.ini, saproute.ini and service files to your users' local PC as in the older SAP GUI releases. For information how to do this, refer to the Frontend Installation Guide.

7. If you want to distribute the server configuration files to another place, you copy the existing server configuration files to the new place. Then, edit the .xml file to change the path for saplogon.ini or and sapshortcut.ini file(s) in the following lines:

```
<File type="Connections" name="..." /> or
<File type="Shortcuts" name="..." />
```

The registry value for "ConfigFileOnServer" or the input for the field Configuration File on Server in the SAP Logon option dialog must be adjusted correspondingly.
You can distribute the server configuration files on an HTTP server. For this, you set the URL for XML Configuration file on server according to bullets 4 or 5 above:

http://.../SapLogonTree.xml

and/or input the URL for the saplogon.ini and sapshortcut.ini files in the XML file like in bullet 7:

<File type="Connections" name="http://.../saplogon.ini" />
<File type="Shortcuts" name="http://.../sapshortcut.ini" />

8. The following information is only important, if you want to use several .ini files:

If different saplogon/sapshortcut .ini files are to be used, these files must be stored in different folders so that the corresponding SapLogonTree.xml file can be created separately by SAP Logon.

To do this, you can start SAP Logon with parameter /INI_FILE= set to the corresponding saplogon.ini file, for example,

/INI_FILE=\Servername\Saplogon\Configuration1\saplogon.ini

for the first saplogon.ini file,

and

/INI_FILE=\Servername\Saplogon\Configuration2\saplogon.ini

for the second saplogon.ini file.

After you finished creating subfolders and assigning entries to the subfolders, all the corresponding xml files created by SAP Logon can be used by your users.

You can then set the server file for your users accordingly, for example, for some users to

\Servername\Saplogon\Configuration1\SapLogonTree.xml

for other users to

\Servername\Saplogon\Configuration2\SapLogonTree.xml

Only one xml file can be set and used at one time for the server configuration in SAP Logon (Pad).

Only one saplogon ini file can be used at one time for starting SAP Logon (Pad) with command parameter /INI_FILE=[Path][name]. See also note 1409494.

See also the next section Caching Server Configuration Files.

2.1.4 Caching Server Configuration Files

When you have selected using central configuration files for SAP Logon entries, all the server configuration files (SapLogonTree.xml, saplogon.ini, sapshortcut.ini if existing) will be cached by default. The cache folder is \%APPDATA\SAP\LogonServerConfigCache.

The files are buffered at the start of SAP Logon when the server is available. Old buffered data is overwritten. Thus, there is only one buffered version.

In case the corresponding server cannot be reached and the server configuration file is not available anymore, the cached files will be used at SAP Logon restart and displayed in the SAP Logon Options → Server Configuration Files dialog under Loaded Server Files. In addition, the user gets a message that now the buffered data is in use.
In case that the given server configuration file and the cache files are not available, only local configuration files will be used. Also in this case, the corresponding message is displayed to the user.

This feature can be switched on and off via the check box Allow caching of server configuration files in the SAP Logon Options → Server Configuration Files dialog. By default, it is activated. In the same dialog you find information on the the XML file and the caching path.

### 2.1.5 Active Directory (LDAP) Support

For information on LDAP support see note 608781.

### 2.1.6 Maintaining System Entries without *.ini/Service File

In SAP Logon, users can maintain (system) connection entries for the Group/Server selection in the Wizard without the local sapmsg.ini and service files existing on their PCs. For more information, see the SAP GUI End User Guide.

### 2.1.7 Disabling SAP Logon Views via Registry

You can set up the SAP Logon in such a way, that some of the three standard SAP Logon views (Explorer/List/Tree view) are not visible for the user.

To disable any of the three available SAP Logon views, create the following registry keys:

- **[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\SAPLogon]**
- **[HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAPLogon]** (32 Bit OS)

- “ShowExplorerView” (REG_DWORD) = 0 (disables the explorer view in SAP Logon)
- “ShowListView” (REG_DWORD) = 0 (disables the list view)
- “ShowTreeView” (REG_DWORD) = 0 (disables the tree view)

- In standard mode, at least one view needs to be enabled.
- In accessibility mode, the list view has to be enabled.

### 2.2 Configuration with SAP UI Landscape

The configuration with SAP UI Landscape is quite different from the installation without this new format. There are less files involved and they are stored in one place. The installation with SAP UI Landscape is explained in the following subchapters. Details on the installation without the new format are explained in chapter 2.1 Configuration without SAP UI Landscape.

In the following subchapters, the configuration with the SAP UI Landscape format is explained using the installation with SAP NetWeaver Business Client (NWBC) as example.

For the SAP GUI installation with NWBC, SAP UI Landscape has to be used.

### 2.2.1 Configuration Files Overview

When installing SAP GUI with SAP UI Landscape, there are only two configuration files involved and they are stored in the same directory.
2.2.2 Configuration Scenarios

There are two scenarios when installing SAP GUI with SAP UI Landscape:

- **Migration:** If SAP GUI has been used already, the data will be migrated once into the new files (see section below).

  After file migration, you can only work on the files in the new format.

- **Setup from scratch:** If SAP GUI has not been used before, you will have to create the configuration files from scratch. This can be done by creating the UI landscape file by hand or on the basis of corresponding output data from an SAP NetWeaver server. See also 6.10 SAP UI Landscape Format XML Description.

On the SAP GUI Family page on SCN, you can find a pdf file with SAP UI Landscape Best Practices for Administrators. The document describes common usage scenarios of SAP UI Landscape.

2.2.2.1 Migration of Configuration Files

The migrated data is imported into the following files:

- Administrator configuration file *SAPUILandscapeGlobal.xml* in %APPDATA%\SAP\Common\ contains migrated data from:
  - NwbcOptions.xml
  - Saproute.ini
  - sapmsg.ini
  - services

- User configuration file *SAPUILandscape.xml* in %APPDATA%\SAP\Common\ contains migrated data from:
  - SAP Logon .ini and .xml files
  - %APPDATA%\SAP\NWBC\NwbcOptions.xml

The concept described above is shown in the following figure that uses the installation with NWBC as example:
2.2.3 Configuration File Provision

The administrator configuration file can be provided either by pull request or by push request.

Note that the pull request is recommended.

2.2.3.1 Provision by Pull Request

If the administrator configuration file is provided by pull request, it is located in a central, shared storage such as a remote share or http server. The advantage of a central storage is that the data does not have to be deployed and that it can be updated centrally.

The administrator must specify the path to the administrator configuration file. Therefore, the administrator defines the path for the key Name: *LandscapeFileOnServer* in

**HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAPLogon\Options (32 bits)**

**HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\SAPLogon\Options** (64 bits)

( REG_EXPAND_SZ)

The local client can then retrieve the administrator configuration file from the central storage (remote share or http server). If this file is not readable for any reason, the last previously loaded version is read from the cache. In addition, the user can create his or her own entries locally. These entries are merged with the central ones. They are displayed in another color (light grey). The advantage of the central data storage and pull request is that an update has only to be stored once.

The concept described above is illustrated by the following figure:
2.2.3.2 Provision by Push Request

When using file provision by push request, the administrator distributes (pushes) the administrator configuration file from his or her data storage repository to the local machines.

SAP GUI then retrieves the administrator connection configuration from the local client, according to the path which is defined in the registry for the key name: `LandscapeFileOnServer` in

- `HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAPLogon\Options (32 bits)`
- `HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\SAPLogon\Options) (64 bits)`

( `REG_EXPAND_SZ` )
The concept described above is illustrated by the following figure:

Thus, push distribution means that the file will not be held centrally on an http server or a central share, but will be sent to the local machines. The recommended folder on the local machines is %ProgramData%/SAP/. The administrator distributes the file with a software distribution tool, such as SAP Setup. This means that during an update the file has to be exchanged on all clients.

Note that because of its disadvantages the push mechanism is not recommended.

Finally, the entries created by the user and the ones created by the administrator are merged and displayed. The latter in light grey.

2.2.4 Configuration File Storage

For information on the configuration file storage, see note 2075150.
2.2.5 Creating and Distributing Configuration Files

A server configuration file can be supplied on a server in a similar way as in the conventional setup with SAP UI Landscape. For information on the creation and distribution of configuration files in the SAP UI Landscape format, see note 2075073.

If you want to provide an administrative core configuration file that can be supplied and set only by an administrator and not by the users, see note 2175351.

2.2.6 Caching Server Configuration Files

Chapter 2.1.4 Caching Server Configuration Files describes the caching in the case of the configuration without SAP NetWeaver Business Client. Except that the cached files are SAPUILandscape.xml files not .INI/Tree.xml, this caching information is also valid for the configuration with SAP NetWeaver Business Client. However, you will find in the latter case additionally two different options on the SAP GUI Options Dialog:

- Update cache on every SAP Logon (Pad) start
- Update cache only in an interval of [hours]

With these options, you can define, with which interval SAP Logon checks the server for new configuration files. When using the first option, the cache is updated with every SAP Logon (Pad) start. With the second option the server is only contacted, if the last enquiry or download took place more than x hours ago. This saves long roundtrips in slow networks.

Using the second option, the check only takes place at SAP Logon start, not during a SAP Logon session.

3. Planning

Purpose

This section tells you how to plan the front-end installation.

Process Flow

1. You plan an installation scenario [page 27].
2. You meet the hardware and software requirements [page 29].
3. You review the installation and maintenance flow [page 30].

3.1 Installation Scenarios

You can install SAP GUI for Windows in the following ways:

- Workstation installation from a server
  The administrator sets up an installation server, from which the installation of the SAP front-end software is run on many different clients.
  All the necessary files are copied from the server to the client during installation.

- Workstation installation from a distribution medium such as a DVD
  The administrator takes the distribution medium from PC to PC. This is mainly for testing or for standalone computers and is not to be used for software distribution.

  We recommend you to use workstation installation from a server because of its greater flexibility, especially if many workstations are involved.

These methods are described in more detail below.
Workstation Installation from a Server

The installation process from an installation server is flexible, easy, and customizable. It makes maintenance easier in any phase of the distribution process, for example, when patches are to be applied.

You have the following options when installing SAP GUI for Windows with server-based workstation installation:

- Without user interaction (unattended)
- With user interaction (attended), where the user can:
  - Select from installation packages that the administrator configured
  - Select from the complete component list of each product available on the installation server

The following figure shows how server-based installation works:

The type of user determines which components to install and on which workstations. Different types of user have different requirements. For example, an employee in the HR department requires different products and components than a software developer.

Using an installation server, the administrator can group various components together as installation packages relevant for certain types of employee. The administrator can also specify which package particular users receive or offer a variety of packages and allow the user to choose the most appropriate one.

In addition, you can configure a distribution service to add local security handling [page 43] (LSH) functions to the installation server. With local security handling, the installation can be started even in the context of a user who is not a member of the local group of administrators. The distribution service then installs a service process on the client and starts NWSAPSetup.exe in the context of this service. The user rights and privileges are not altered. The installed service does not start other processes except NWSAPSetup from configured installation servers.
The hard disk requirement on the installation server depends on the type and number of products that are added to an installation server. SAP GUI for Windows requires approximately 800 MB with all components installed.

As administrator, you can configure your own installation packages with NWSAPSetupAdmin.exe on the installation server or use the preconfigured packages provided by SAP.

You apply patches on the installation server and call NWSAPSetup on your client again to apply the patch on the client. You can control the installation using the command line. You can perform unattended installations with automatic patch installation on the client. To do this you place the appropriate command line in the logon script of the client. The logon script is a program that is executed when you log on.

Alternatively, you can use the SAP Automatic Workstation Update. Whenever the installation server is patched, or the packages installed are updated, this service will update the workstation(s) and reboot them if necessary. The workstation updater works in two modes - one in the presence of a logged-on user and another in his or her absence:

- When a user is logged on, the user is informed of update availability and the update happens on the user's assent. The user is also informed if a reboot is necessary and the reboot is also only executed on the user's assent.

- If no user is logged on, the update is done automatically and the reboot (if necessary) is done automatically, too.

The SAP Automatic Workstation Update is not SAP GUI-specific, it works with all components available on the installation server. For detailed information, see section 3.9 Configuring SAP Automatic Workstation Update.

**Workstation Installation from a Distribution Medium**

Local installation on workstations with a distribution medium such as a DVD is useful for installing SAP GUI on single machines (for example, laptops) that are not connected to a Local Area Network (LAN). You can also use it for test purposes.

This installation type has the following disadvantages:

- No installation scenarios are available.
- When patches need to be applied, you need to patch each workstation separately.

### 3.2 Hardware and Software Requirements

You need to make sure in advance that your system meets the following requirements:

- **Front-end workstations:**
  - Read [SAP note 26417](#) to check that all hardware and software requirements for the front-end workstations have been met.
  - Hard-disk clones only:
    - If the operating systems of your client computers were generated through hard-disk cloning, make sure that the domain is set correctly. To do this, take the computers out of the domain and then put them back in. This is especially important if you intend to use local security handling (LSH) [page 43].

- **The host for server-based installations must:**
  - Be accessible to all users at any time, even after the installation is complete
    - This is required for maintenance purposes such as the distribution of patches.
  - Have broadband network connection for high throughput
○ Have 800 MB of free disk space
○ Use server version of XP, Vista, Windows 7 or 8

3.3 Installation and Maintenance Flow

Purpose
This section describes a typical installation and maintenance flow for a server-based workstation installation.

Process Flow
1. You set up an installation server [page 31] and, if necessary, local security handling [page 43] (LSH).
   The installation server contains:
   ○ Installation programs
   ○ Configuration information (for example, packages)
   ○ Service files (for local security handling)
   ○ Front-end components to be installed
2. You maintain installation packages [page 36] for different user groups.
   Users can install multiple packages and packages can share components. You can configure installation parameters, such as installation directories for the components that a package contains.
3. We recommend that you configure local security handling [page 43] and test it.
   You can do this by logging on to a user PC with a user that does not have local administrator rights and running NWSAPSetup.exe.
   Many Windows operating systems have local security mechanisms. In these systems, only users with local administrator rights have write access to parts of the system database and the file system.
   NWSAPSetup solves this problem with the Distribution Service (DS), which resides on the server, and the Installation Service (IS) that has been installed on the workstation. The IS starts a new instance of NWSAPSetup.exe that runs with sufficient privileges.
4. You install packages using the logon script [page 51] of your PC or using other software distribution technologies.
5. You patch the installation server [page 42].
6. You upgrade the front-end [page 54] client computers when a new front-end release becomes available.

4. Preparation

Purpose
This section tells you how to prepare an installation server for the front-end software installation.

Process Flow
1. You set up an installation server [page 31].
2. If required, you administer your installation server [page 33].

3. If required, you add new SAP front-end components to an existing installation [page 33].

4. If required, you update products on the installation server with a newer version using a patch [page 35].

5. If required, you create and maintain installation packages [page 37].

6. If required, you patch the installation server [page 42].

7. If required, you configure local security handling [page 43].

After you have set up the installation server, it is ready for use during the deployment of SAP front-end components on the workstations.

Creating packages for deployment is optional. Packages contain administrator-selected components, which are helpful to regulate and customize installation parameters such as the installation directory.

### 4.1 Setting Up an Installation Server

**Use**

You use this procedure to help distribute SAP front-end software on multiple workstations on the network.

`NWCreateInstServer` is a wizard driven tool that helps the administrator create a new installation server. After the server is set up, `NWUpdateInstServer` starts importing SAP products from the source into the newly created server.

**Prerequisites**

You need local administrator rights under Windows operating systems with local security mechanisms.

**Procedure**

1. Execute the file `NwCreateInstServer.exe` from the SETUP folder of the DVD `SAP Product Media`.

2. Choose Next to continue.

   You can choose Cancel at any stage to abort the process.

   `NWCreateInstServer.exe` prompts you to supply the path where you want to create the installation server.

3. Enter the folder name manually or use Browse to navigate to the folder where you want to create the installation server. Make sure the folder is empty.

4. Choose Verify to make sure that the chosen folder meets the prerequisites:
   - It must exist.
   - It must be accessible to the administrator with full access.

   The folder is automatically configured. It is made NULL-session accessible. Thus, it will be automatically shared on the network for everyone to read. If you do not want this automatic configuration, use the command line parameter `DontConfigureServerPath`.

5. If required, choose Share to maintain the file-sharing properties of the selected folder.
6. Choose Next to continue.

You see a screen indicating that the server is being created.

Processing is recorded in the following file:

%ProgramFiles%\SAP\SAPSetup\Logs\NwCreateInstServer.log.

If there are errors, you see a link to an Error Report. Any errors are recorded in the following file, which you can view using your normal web browser:

%ProgramFiles%\SAP\SAPSetup\Errors\NwCreateInstServer_<CurrentDateTime>.xml.

If you have a problem, create a problem message on component BC-FES-INS and attach these files to the message.

When the installation is complete, you see a screen confirming that the server has been successfully created.

You now have a valid but empty SAPSetup installation server.

7. Choose Next to continue.

NwCreateInstServer.exe automatically calls NwUpdateInstServer.exe to transfer SAP products to your installation server.

8. Choose Next to continue.

You see the following screen:

C:\MyNewInstServer is the path where NwCreateInstServer.exe initially created a new installation server in this example.

9. Enter the folder name manually or use Browse to navigate to the folder of the installation server that you want to update.

10. Choose Next to start the server update.
You see a screen indicating that the server is being updated.

Processing is recorded in the following file:
%ProgramFiles%\SAP\SAPSetup\Logs\NWUpdateInstServer.log

If there are errors, you see a link to an Error Report. Errors are recorded in the following file, which you can view using your normal web browser:
%ProgramFiles%\SAP\SAPSetup\Errors\NWUpdateInstServer_<CurrentDateTime>.xml

If you have a problem, create a problem message on component BC-FES-INS and attach these files to the message.

NWServerUpdate.exe transfers all SAP products available on the DVD or source to the installation server.

When the update is complete, you see a screen confirming that you can use the installation server for SAP product installation on end-user workstations.

11. If you have .NET Framework version 4 installed, choosing Finish automatically starts NWSAPSetupAdmin.exe from the recently updated installation server.

The new NetWeaver SAPAdmin is a multi-product server administration tool.

More information: Administering an Installation Server [page 33]

You can replicate an installation server to an existing network share by entering the following command:
\\InstallationServerShare\Setup\NwCreateInstServer.exe /Dest=<ReplicationPath> /NoDlg

After setting up your installation server, it is recommended to look for the latest patches. See also chapter 3.7 Patching the Installation Server.

4.2 Administering an Installation Server

Use

After you have successfully set up the installation server, you can find NWSAPSetupAdmin.exe in the SETUP directory of the installation server.

NWSAPSetupAdmin.exe is designed to help you administer the multi-product installation server. It supplies the following features:

- Import Product
  Use this feature to add new products (for example, SAP front-end components) to an existing installation server for distribution over the network.

- Export Product
  Use this feature to export front-end components available on one installation server to another.

- Delete Product
  Use this feature to delete a product from an installation server.

- Create Package
  Use this feature to create packages for deployment. Packages can contain many components and their installation parameters can also be customized.
- **Create Package Definition File (PDF)**
  You can create a package definition file (PDF) for an installation server package. PDF is a package description format that simplifies the interoperability and information exchange between the SAP Installer and system management products like the System Management Server from Microsoft.

- **Configure Package**
  Use this feature to change the attributes or the content of your packages.

- **Patch**
  Use this feature to patch components that are available on the installation server.

- **Local Security Handling**
  This feature allows workstation users to install SAP components from the installation server without requiring administrative privileges.

  NWSAPSetupAdmin.exe requires the .NET Framework 4 to be installed as a prerequisite. You can download the .NET Framework from:
  

- **Configuring SAP Automatic Workstation Update**
  Whenever the installation server is patched, or the packages installed are updated, this service will update the workstation(s) and reboot them if necessary. The workstation updater works in two modes - one in the presence of a logged-on user and another in his or her absence:

  ○ When a user is logged on, the user is informed of update availability and the update happens on the user's assent. The user is also informed if a reboot is necessary and the reboot is also only executed on the user's assent.

  ○ If no user is logged on, the update is done automatically and the reboot (if necessary) is done automatically, too.

- **Control Remote Workstations**
  This functionality uses the Windows Management Instrumentation (WMI) to help you remotely access and control workstations on which you have administration privileges. You access this feature via the Remote menu, where you find the options to:

  ○ collect remote log files
  ○ execute processes remotely
  ○ enumerate remote processes
  
  You find detailed information in section Controlling Remote Workstations.

### 4.3 Adding New SAP Front-End Components to an Existing Installation Server

**Use**

This procedure tells you how to transfer new SAP front-end components on a distribution medium to your installation server. Then you can deploy them to the workstations on the network.
You can add SAP products either using NWUpdateInstServer.exe or NWSAPSetupAdmin.exe (using the import product wizard) that you can find in the SETUP directory of the source medium.

**Prerequisites**

- An existing installation server
- A medium that contains an SAP product to be added to the installation server
- Enough disk space

You must not use the installation server during processing.

**Procedure**

To update the installation server with new SAP components, use one of the following two methods:

- **Using NWUpdateInstServer.exe**
  a. Start NWUpdateInstServer.exe from the SETUP directory of the source that contains the component to be added.
  b. Supply the path of the installation server.
  c. Follow the wizard to update it with components that are available on the source.

- **Using NWSAPSetupAdmin.exe**
  a. Start NWSAPSetupAdmin.exe from the SETUP directory of the installation server that needs to be updated with the new component.
  b. In the toolbar, choose *Import Products*.
  c. Follow the wizard and supply the path to the source containing the product to be added to the installation server.

**Example**

You can update the installation server with the Adobe LiveCycle Designer which is delivered on the same DVD as the SAP GUI for Windows. You just have to start the program `<Disc Drive of DVD>:\ADOBE_LC_<release>\setup\NwUpdateInstServer.exe`. After being shown a welcome page, you will be asked for the path to the installation server that should be updated. Here, you must navigate to the path of the installation server which has been set up in section 3.1 (C:\MyNewInstServer). You just have to choose *Next* and wait until the process ends. Afterwards, the SAPSetup Installation Server Administration Tool (NwSAPSetupAdmin.exe) is displayed. On the *Products* tab, you will see the added product Adobe LiveCycle Designer.

The user can now install the product by starting the program `<Path of the installation server share>\SetupAll.exe` and selecting the product to be installed, in this case the Adobe LiveCycle Designer.

**4.4 Updating Products on the Installation Server with a Newer Version**

**Use**

If newer releases of SAP products or components are required, you have to update your installation server to be able to distribute these new products to the workstations using a network.
This wizard-driven process is handled by a tool called NWUpdateInstServer.exe that you can find in the SETUP directory of your source medium.

**Prerequisites**

- A medium with an SAP product in a release newer than that on the installation server
- Enough disk space

You must not use the installation server during processing.

**Procedure**

1. Follow the steps as described in Adding New SAP Front-End Components to an Existing Installation Server [page 34].
2. Start NWUpdateInstServer.exe from the source medium.
3. Follow the instructions in the wizard.

You can also update products on the Installation Server by using the following command line:

```
\\UpdateSource\Setup\NwUpdateInstServer.exe /dest=<installation server setup directory> /NoDlg or /silent
```

For a description of the command line parameters see section 5.5.

### 4.5 Deleting Products from the Installation Server

To delete products from the installation server, proceed as follows:

1. Start NWSAPSetupAdmin.exe from the SETUP directory of the installation server where you want to delete a product.
2. On the Products tab, right-click the product to be deleted and choose Delete Product. The product deletion wizard appears.
3. Follow the deletion wizard.

At the end of the deletion process, a message will inform you, if the deletion process completed successfully.

If you delete a product that is still a part of a preselection package, the indicator appears next to name of the affected package on the Packages tab. This indicates that a product that is a part of the package is not available on the installation server. Thus, either the package has to be deleted or the product must be re-imported into the server from another source.

### 4.6 Creating and Maintaining Installation Packages

After setting up an installation server, you can create packages for an installation performed by users. The tool that you use is NWSAPSetupAdmin.exe, which you can find in the SETUP folder on the installation server.

The package creation and deployment in the new NetWeaver SAPSetup is enabled on multiple-product level, so enabling the administrator of the installation server to create packages comprising more than one SAP front-end component and parts.
4.6.1 Creating a New Installation Package

Procedure

1. Start NWSAPSetupAdmin.exe from the SETUP folder of your installation server.

2. In the toolbar, choose New Package.
   The Package Creation Wizard appears.

3. To continue, choose Next.
   The wizard displays components available on the installation server.

4. Select the products that you want to add to your package.
   Yellow dots indicate changes in the selection list. The green plus signs next to the product names indicate that these products will be installed when the user installs the package on his or her workstation.

5. Choose Next.
   You are prompted for a package name.

6. Enter a name and choose Next.
   NWSAPSetupAdmin.exe now creates a package and confirms the successful creation.

7. To return to NWSAPSetupAdmin.exe, choose Finish.
   The newly created package is now visible in the Package View.

8. Right-click a package and choose Configure from the context menu to customize installation parameters, such as the installation path for components contained in the package.
4.6.2 Configuring Packages and Scripting Events

Purpose
Package configuration lets the administrator change the attributes of a package (for example, the name), give the package a description, set registry keys for the package and customize the installation of the package by adding scripts that are to be executed during events in the package deployment cycle.

Prerequisites
- An installation server
- Packages created by the administrator and available for customization

Process Flow
1. Start NWSAPSetupAdmin.exe from the SETUP directory of the Installation Server.
2. Switch to the Configure Packages tab page. In the left window pane, you can see a tree listing the existing packages.
   - The indicator next to a package indicates that the package is incomplete. This typically occurs when a product that the package contains has been deleted from the installation server. You can either delete this package or re-import the missing product.
3. Select the package that you want to customize. You can for example change the name of the package, add a description, set registry keys for the package or script events.
   - The text supplied as description is eventually visible to the end-user wanting to install the package using NWSAPSetup.exe.
4. Optional: You can set registry values on package level, for example, for the following registry keys:
   - Registry keys of the Accessibility page
   - Path to the SAP GUI branding image
   - Path to the Central Configuration File (new and old format)
   - Theme Key etc.
   You find the whole list on the package configuration tab.
   To change a registry key setting for the package, choose Modify Parameters. A window opens where you can choose the variable name and enter the corresponding value below. You find a description of the registry key values in the SAP GUI Administration Guide.
   - Limitation: Later, this setting cannot be changed with the same tool again. Changes have then to be done via scripting.
5. Optional: Add event-scripting to perform custom actions on the user’s workstation during the installation of the package (for example, copying additional files). You can insert scripting samples delivered by SAP via Insert Script and adapt them to your requirements. The scripts are executed at the following events:
   - On Begin Install: executed before the installation of a selected package
   - On End Install: executed after the completion of package installation
   - On Begin Uninstall: executed before the uninstallation of a selected package
○ On End Uninstall: executed after the completion of package uninstallation
○ On Begin Update: Executed before the update of a selected Package.
○ On End Update: Executed after the completion of the Package update.

To learn more about the package update option see the next section Changing the Package Content.

6. To save your changes, choose Save.

Sample documentation
The documentation of the samples for package event scripting is contained in the SAP Setup Guide.pdf file, which you can find using the SAPSetup Installation Server Administration Tool (NWSAPSetupAdmin.exe) by choosing the Help Menu –> SAP Installation Server Help. In this documentation, navigate through the tree structure as follows: Administering an Installation Server –> Maintaining Installation Packages –> Configuring Packages and Scripting Events –> Package Event Scripting Samples.

4.6.3 Changing the Package Content

Purpose
The package configuration lets the administrator also update the package content. This means, you can add or remove components to be installed with the package. Also, you can add scripts that are to be executed before or after the update.

Prerequisites
● An Installation Server
● Packages created by the administrator and available for customization.

Process Flow
1. Start NWSAPSetupAdmin.exe from the SETUP directory of the Installation Server.

2. Switch to the Configure Packages tab. In the left window pane, you can see a tree listing the existing packages.

The indicator next to a package indicates that the package is incomplete. This typically occurs when a product that the package contains has been deleted from the installation server. You can either delete this package or re-import the missing product.

3. Select the package for which you want to update the content, and choose Change Package Content.

You can now select or deselect components. Components added will be newly installed on the workstations. Those removed will be uninstalled from the workstations, if they are not part of any other package marked for installation. When updating a package, the package installation parameters are also refreshed and include new variables or delete those that belong to components that are no longer part of this package.

4. Optional: Add event-scripting to perform custom actions on the user's workstation during the update of the package. You can insert scripting samples delivered by SAP via Insert Script and adapt them to your requirements. The scripts will be executed before and after the update:

   a. On Begin Update: Executed before the update of a selected Package.
   b. On End Update: Executed after the completion of the Package update.
5. Remember to click the Save button to persist changes made. Saving the package increases the version number and the package is marked for update on the workstation. When the package installation is updated on the workstation, the package components that have been newly added or removed by the administrator are automatically installed or uninstalled respectively.

If you are using package event-scripting to transfer your files, the Mark for Update link as seen on the Configure Packages tab can be used to inform the installer of the availability of an update after you have modified this file. The installer will now recognize the package as updated and the modifications will be transferred to the workstations at update time via the OnBeginUpdate and /or OnEndUpdate scripts.

4.6.4 Deleting an Installation Package

Procedure
1. Switch to Package view.
2. Right-click the package you want to delete.
3. From the context menu, choose Delete Package.

The package is deleted. It is removed from the Package view.

4.6.5 Creating a Package Definition File

Use
You can create a package definition file (PDF) for an installation server package. PDF is a package description format that simplifies the interoperability and information exchange between the SAP Installer and system management products like the System Management Server from Microsoft.

Procedure
Proceed as follows to create a package definition file:
1. If not already started, start NWSAPSetupAdmin.exe from the SETUP directory of the installation server.
2. On the Packages tab, right-click the package for which you want to create a PDF file and choose Create Package Definition File.
3. Choose the directory where you want to save the file, enter a file name, and choose Save.

Result
NWSAPSetupAdmin.exe creates a PDF and an SMS file in the specified directory.

4.6.6 Creating and Deploying Self-Installing Packages

Use
You can create single-file self-installing .exe-packages via NWSAPSetupAdmin.exe.
Such a package contains only those files that belong to the components that are a part of the package. Thus, it reduces your network load in certain distribution scenarios where you previously had to make local copies of your installation source before installing.

This single-file self-installer can also install silently without user interaction.

**Prerequisites**

- You have created a SAP installation server using `NWCreateInstServer.exe` available with your SAP GUI DVD, or inside the `SETUP` folder of any other SAP software installed using SAP Installer.
- You have created a package or packages that contain the desired components.
- Optional: If you want to distribute configuration files, e.g. `saplogon.ini`, together with the self-installing package, create a folder on the installation server named `CustomerFiles`, and copy your files in this folder. See also the scripting example `Sample 1: Copying a file that you find by following the instructions given in section Configuring Packages and Scripting Events`, point 4.

**Procedures**

Proceed as follows to create or deploy a self-installing package:

**Creating a self-installing package**

1. Start `NWSAPSetupAdmin.exe` (you will need .NET 2.0 to use this version).
2. In the Packages tree, right-click the package you want to create a self-installing file from, and choose Compress Package To Single-File Installer.
3. Following the wizard instructions, you will get a single exe-self-extractor at the end of the process.

**Deploying a self-installing package**

1. The self-installing file created above can be executed on any workstation to install your package.
2. Follow the installation wizard.

   This self-installing package can be installed silently (i.e. without user-interaction) when invoked with the command-line parameter `/silent`.

**Result**

You have created and deployed a self-installing package.

**Troubleshooting**

If you face problems with creating a self-installing package, check first that your server has no missing files - via the `Check Server` feature in the NWSAPSetup administration tool (`NwSapSetupAdmin.exe`).

If you encounter problems with installing the self-installing package, use the Check-Workstation tool (`NwCheckWorkstation.exe`).
4.7 Patching the Installation Server

Use
Patching products on the installation server keeps them up-to-date with the most recent correction and enhancements from SAP.

You can configure the SAP Automatic Workstation Update. This service will update the workstation(s) and reboot them if necessary whenever the installation server is patched, or the packages installed are updated. The workstation updater works in two modes - one in the presence of a logged-on user and another in his or her absence. For detailed information, see section 3.9 Configuring SAP Automatic Workstation Update.

Prerequisites
- An existing installation server
  - To ensure a successful patch and to avoid having to reboot after the patch, you can unshare the installation server during the patch and recreate it when the patch has finished.
- A patch supplied by SAP for products or components available on the installation server.

Procedure
1. Start NWSAPSetupAdmin.exe from the SETUP directory of the installation server.
2. Choose Patch Server.
   - This starts the patch wizard.
3. Choose Next to continue.
4. Browse to a valid SAP patch file and choose Next to continue.

   NWSAPSetupAdmin.exe now validates the patch, which takes a few minutes.
   
   If the patch is valid, you are prompted to proceed with it.
   
   To ensure that the installation server is not in use, the patch now closes NWSAPSetupAdmin.exe before continuing. It restarts NWSAPSetupAdmin.exe after completing the patch.
5. Choose Next to continue.

   NWUpdateInstServer.exe starts patching the installation server.
6. Follow the patch wizard, choosing Next as required.

   Processing is recorded in the following file:
   
   %ProgramFiles%\SAP\SapSetup\Logs\NWUpdateInstServer.log.
   
   If there are errors, you see a link to an Error Report. Any errors are recorded in the following file, which you can view using your normal web browser:
   
   %ProgramFiles%\SAP\SapSetup\Errors\NWUpdateInstServerErrors_<CurrentDateTime>.xml.
   
   If you have a problem, create a problem message on component BC-FES-INS and attach these files to the message.
   
   At the end of the process, you see a message indicating that the patch was successful.
7. Choose Finish.
NWSAPSetupAdmin.exe now restarts.

If you have patched a SAP front-end component (for example, SAP GUI for Windows 7.40), the version number of this component in NWSAPSetupAdmin.exe increases after applying the patch.

4.8 Configuring Local Security Handling

Use

Local security handling (LSH) lets users on the network deploy SAP front-end components on their front ends using NetWeaver SAPSetup without requiring administrative privileges on each front end.

Prerequisites

- You have set up an installation server [page 31].
- To enable front ends running Windows Vista or higher to use LSH, you need to change the default firewall setting to enable remote service management as follows:
  a. Open the control panel and choose Windows Firewall → Change Settings.
  b. On tab page Exceptions, select Remote Service Management and choose OK.

Procedure

1. Start NWSAPSetupAdmin.exe from the SETUP folder of the installation server.
2. Choose Services and select Configure local security handling.
   The LSH configuration wizard starts.
3. Choose Next.
   The wizard prompts you for the credentials of an account that has administrative privileges for all front ends on the network.
4. Enter the account name with domain qualifiers.
5. Choose Verify.
   Verification only confirms that the password supplied matches its repetition. Verification does not validate credentials.
6. Choose Next.
7. Enter details for the installation service (IS) account, verify, and choose Next to complete the process.
   The wizard displays the success state in starting the distribution service and the status bar at the bottom of NWSAPSetupAdmin.exe displays the service state as Active.
8. Test the functioning of the LSH feature by starting NWSAPSetup.exe from this installation server on a front end where the logged-on user has ordinary user privileges (that is, the user does not have administrative privileges).

Result

If the front-end installer starts successfully and is able to install components available on the installation server, the configuration is successful.

If not, you need to reconfigure LSH.
4.9 Configuring SAP Automatic Workstation Update

Use

The SAP Automatic Workstation Update works only when installed on the workstation. Whenever the installation server is patched, or the packages installed are updated, this service will update the workstation(s) and reboot them if necessary. The workstation updater works in two modes - one in the presence of a logged-on user and another in his or her absence:

- When a user is logged on, the user is informed of update availability and the update happens on the user’s assent. The user is also informed if a reboot is necessary and the reboot is also only executed on the user’s assent.
- If no user is logged on, the update is done automatically and the reboot (if necessary) is done automatically, too.

This service updates itself, when a patch of automatic workstation update is available.

Prerequisites

The workstation side needs a network connection to the installation source for any update to be possible.

On the installation server side, the following prerequisites must be met:

1. The installation server should be hosted on a machine that can work as a file-server and serve numerous network sessions.
2. Windows Server 2003 (or equivalent) is recommended as the installation server operating system with the following ‘Local Security Policy’:
   - “Accounts: Guest account status” – Enabled.
   - “Network Access: Let Everyone permissions apply to anonymous users” - Enabled.
3. The installation server should be created (and hence configured) using NWCreateInstServer.exe.

Procedure

In order to configure automatic workstation update, proceed as follows:

1. Open the administration tool NWSapSetupAdmin.exe.
2. Choose Services -> Configure automatic update.
   The screen Automatic Workstation Update Configurations appears as shown in the following picture:
You have now several options:

a. Update re-check frequency
   The workstations that will have this feature installed, will poll the installation server at this interval to check for update availability. The default is 24 hours.

b. Enforce reboot after every update
   When this flag is not set, the user is asked to reboot only if it is required to complete the deployment process. When the flag is set, a reboot is enforced, which means that the user is always asked to reboot.

c. Additional Update Sources (optional)
   You can index additional servers. The update service will then look up the indexed servers per line in the given order for available updates.

3. Save your entries and close the program.

To make the automatic workstation update service available on workstations, you should create a package using `NWSapSetupAdmin.exe` on the installation server. This package should consist of SAP GUI for Windows and SAP Automatic Workstation Update. Once automatic workstation update is installed, then the following programs will run on the workstation in the background:

- `NWSAPSetupUserNotificationTool.exe`
- `NWSAPAutoWorkstationUpdateService.exe`

The front-end side will query the last 10 installation sources that are network paths.

**Result**

You have configured the SAP Automatic Workstation Update and made it available on the workstations.

To disable the service, activate the option *Disable Automatic Workstation Update* in the configuration tool on the installation server (see picture above). This configuration change is propagated as an update to the workstations at the time of the next update check.
Once disabled, this action cannot be undone until the Automatic Workstation Update Service is reinstalled.

4.10 Controlling Remote Workstations

Use

The remote workstation control functionality helps you to remotely access and control workstations on which you have administration privileges.

Prerequisites

- Since this functionality uses the Windows Management Instrumentation (WMI) service, WMI has to be enabled.
- The firewall should be configured, so that WMI access is not blocked.
- You need to be an administrator on the workstation you want to access. This means, you should have either domain administrator privileges or local administrator rights for the corresponding machine.

Procedure

In order to control workstations remotely, proceed as follows:

1. Open the administration tool NWSapSetupAdmin.exe.
2. Choose Remote.

   You have now several options:
   a. Collect remote log files

      With this option, you can collect log files from remote workstations. For this, you just have to enter the workstation name. In case you want to collect log files from several machines, you have to separate the different names by a comma.

      Concerning the section Optional - Administrative Credentials: You need to supply administrative credentials for the workstation only if you are not running this application using the same credentials. For example, if you are domain administrator and the workstation is not part of your domain; however, you have local administration rights for the machine. Then you would enter your local administration credentials here. This data will not be saved.

      Finally, you choose Collect to collect the log files from the remote workstations. If you want to stop the collection process, just press Abort. When the file collection is finished, Windows Explorer opens automatically the corresponding folder under %temp%\SAPRemoteWksta\.

   d. Execute processes remotely

      With this option, you execute processes on a remote workstation. You just have to enter the workstation name as well as the application name in the appropriate field. Also, you can supply the application with the appropriate command line parameter, for example: c:\program files\sap\sapsetup\setup\nwsapsetup.exe /uninstall /all /silent. Then choose Execute to run the process on the remote machine.

      Start only non-interactive processes with this feature, because WMI will not allow the application started remotely to interact with the user.
To get a list of running processes, use option Display Running Processes (for details see also paragraph 'Enumerate remote processes' below).

e. Enumerate remote processes

With this option, you get a list of processes running on a remote workstation. Just enter the workstation name and choose Display. If you want to terminate a process, select the process and choose Terminate.

⚠️ Be careful with the Terminate option, because the user may lose unsaved data.

Troubleshooting

If you encounter problems with the WMI feature, diagnose WMI connectivity to a remote workstation using the Microsoft tool wbemtest.exe. Note, that you have to supply the connection namespace as `\\WorkstationName\root\cimv2`.

Delegation

In order to start an installation on a remote workstation that is located on an installation server, delegation is required to be activated for the client machine(s) in question. Please, refer to the Microsoft TechNet article at [http://technet.microsoft.com/en-us/library/ee692772.aspx](http://technet.microsoft.com/en-us/library/ee692772.aspx), question 10 for further details.

5. Installation Process

Purpose

This section provides information about the steps that you have to perform to install your SAP front end.

Prerequisites

You have completed planning [page 13] and preparation [page 30] before you start the installation.

⚠️ In the event of errors, consult the log files [page 58] before creating a problem message.

If required, create a problem message in BC-FES-INS and attach these files to the message.

Process Flow

1. You perform the installation [page 47].
2. You perform the required software updates [page 54].

5.1 Installation of the SAP Front End

Purpose

This section describes how you install the SAP front-end software.

Process Flow

You install components on your front end centrally from an installation server [page 48] or locally from a distribution medium [page 52] such as DVD.
5.1.1 Installing Components from an Installation Server

Use
This procedure tells you how to install components from an installation server. More information on how to install packages from an installation server:

- Installing Packages Configured by the Administrator [page 50]
- Installing Packages Using the Logon Script [page 51]

Prerequisites

- You have already set up an installation server [page 31].
- The user logged on to the front end must have local administrative privileges.
- If the user does not have local administrative privileges, make sure that local security handling is correctly configured [page 43] on the installation server.

Procedure

1. Start NWSAPSetup.exe from the SETUP folder on the installation server.
   The SAPSetup installation wizard appears.

2. Choose Next.
   The product list is displayed. Products that have already been installed are pre-selected as shown in the following picture:

   ![SAP Front End Installer](image)

   Select all | Deselect all

   **SAP FRONT-END INSTALLER**

   - SAP NetWeaver Business Client 5.0
   - SAP GUI for Windows 7-40 (Compilation 2)
   - Install SAP GUI Desktop Icon / Shortcuts even if offline
   - KW Add-On for SAP GUI 7-40
   - Use JAR File for Planning Grid
   - SAP Automatic Workstation Update
   - Business Explorer
   - SAP 3D Visual Enterprise Viewer 8.0 SP3 MP1
   - SAP Intelligent Client Tools
   - SAP GUI Screen Reader Extension for JAWS
   - SAP Cloud Connector

   The SAP NetWeaver Business Client 5.0 is a high-fidelity desktop client that allows the user to display his assigned roles, and to launch applications.

3. Select the products or SAP front-end components that you want to install or deselect the ones you want to remove.
   Yellow dots indicate changes in the selection list. The green plus next to a product name indicates that this product will be installed when the user installs the package on his or her workstation.
If you deselect a product in this list that has already been installed, a red minus appears to indicate that this product is marked for uninstallation.

4. After (de)selection, choose *Next*.

The installation wizard might prompt you to enter or change information to customize the installation of the selected products, such as the installation folder.
The default path for installing SAP GUI for Windows is C:\%ProgramFiles%\SAP\FrontEnd, but you can change this if required.

5. If necessary, change this information and choose Next to start the installation.

The installation starts and a progress screen appears.

Processing is recorded in the following file:
%ProgramFiles%\SAP\SAPsetup\Logs\NWSAPSetup.log

If there are errors, you see a link to an Error Report. Errors are recorded in the following file, which you can view using your normal web browser:
%ProgramFiles%\SAP\SAPsetup\Errors\SAPSetupErrors_<DateTime>.xml

If you have a problem, create a problem message on component BC-FES-INS and attach these files to the message.

When the update is complete, you see a confirmation screen. Your SAP front-end component is now successfully configured and ready to use.

5.1.1.1 Installing Packages Configured by the Administrator

Use
This procedure lets you install or remove packages on your front end that have been configured by the administrator on the installation server.

⚠️ Be careful when removing packages. Make sure you do not mistakenly remove shared components that are used by other packages you want to keep.

Prerequisites

- You have already set up an installation server [page 31].
- The user logged on to the front end must have local administrative privileges.
- If the user does not have local administrative privileges, make sure that local security handling is correctly configured [page 43] on the installation server.
- The administrator has created packages using NWSAPSetupAdmin for deployment on the front end.

Procedure

1. Start NWSAPSetup.exe /package from the SETUP folder of the installation server or distribution medium.

A list of the packages that the user is authorized to install or uninstall is displayed. Packages that have already been installed are pre-selected. In the following case, the package Hospital Planning Package is already installed on the workstation.

2. Select the components or packages that you want to install or deselect the ones you want to remove.
In this case, the BW Package has been selected for installation. The yellow dot indicates a change in the selection list. The green plus next to the product name indicates that this object will be installed when the user installs the package on his or her workstation. If you deselected a package, you would see a red minus next to the object selected for de-installation.

3. After (de)selection, choose Next.

NWSAPSetup now processes the packages and displays the completion status when finished.

If errors occur during the installation, SAPSetup displays a link to a document in which the errors have been logged. Contact the administrator of the installation server or the network and pass on the information given in this document.

5.1.1.2 Installing Packages Using the Logon Script

Use
Since the front-end software is normally installed on a large number of computers, NWSAPSetup lets you automate this task.

By inserting a command line into the logon scripts of the computers on which the front-end software is to be installed, you can start a package installation each time the user logs on.

Prerequisites
Make sure that the front-end software (especially SAP GUI) is not running when you perform the procedure below because program files in use might cause a reboot.
Procedure

Enter the following command (both the path and either the package name or unique package identifier must be used):

```
\<server>\<shared folder>\setup\NWSAPSetup.exe /package:"<package command-line name>" /silent
```

You can also call NWSAPSetupAdmin.exe in the same way to perform this task.

When you start this command for the first time on a computer, NWSAPSetup installs the specified package.

For a list of options, see Command Line Parameters [page 59].

5.1.2 Installing Components Locally from a Distribution Medium

Use

This procedure installs SAP front-end software components on a single computer from a distribution medium such as a DVD.

Prerequisites

The user logged on to the front end must have local administrative privileges.

Procedure

1. In folder Gui\Windows\Win32 on the SAP NetWeaver Presentation DVD, start SAPGUISetup.exe.

   The SAPSetup installation wizard appears, showing you a list of components that are part of the product SAP GUI for Windows.

   To view and optionally install all products – that is, SAP front-end components available on the installation medium including SAP GUI and others (the SAP NetWeaver Presentation DVD contains SAP GUI for Windows and SAP BI front end as well as other components that can be integrated on an individual basis) – use SetupAll.exe.

2. Choose Next.

   A list with (de)selectable products is displayed:
Products that have already been installed are pre-selected.

3. Select the products or SAP front-end components that you want to install or deselect the ones you want to remove.

Changes in the selection list are indicated by a yellow dot. If you select a product for installation, you will see a green plus next to the product to install. If you select a product for de-installation, a red minus appears as shown in the following picture:

4. Choose Next.
The installation wizard might prompt you to enter or change information to customize the installation of the selected products, such as the installation folder.

The default path for installing SAP GUI for Windows is %ProgramFiles(x86)%\SAP\Frontend, but you can change this if required.

5. If necessary, change this information and choose Next to start the installation.

The installation starts and you see a progress screen.

Processing is recorded in the following file:
%ProgramFiles%\SAP\SAPsetup\Logs\NWSAPSetup.log

If there are errors, you see a link to an Error Report. Errors are recorded in the following file, which you can view using your normal web browser:
%ProgramFiles%\SAP\SAPSetup\Errors\SAPSetupErrors_<DateTime>.xml

If you have a problem, create a problem message on component BC-FES-INS and attach these files to the message.

When the update is complete, you see a confirmation screen. Your SAP front-end component is now successfully configured and ready to use.

5.2 Update of the SAP Front End

Purpose
This section describes how you update the installed front ends when a newer version is available as a patch either on the installation server or on a distribution medium (such as a DVD).

Patches for SAP GUI for Windows do not contain the complete set of files required for SAP GUI for Windows. Therefore, you cannot upgrade to a new release by just applying a patch for the new release to your existing installation.

Instead you have to start the installation of the new release using the SAP GUI version delivered on the SAP NetWeaver Presentation DVD. Afterwards you can use patches to update the new SAP GUI for Windows release.

Process Flow
You can update the SAP front end in one of the following ways:
Updating the Front End from an Installation Server [page 54]
Patching a Standalone Front End [page 54]

5.2.1 Updating the Front End from an Installation Server

Use
You can update the front end from an installation server.

Procedure
Updating the front end basically involves the same steps as an installation, see section Installation of the SAP Front End from an Installation Server [page 47].

You have the possibility to have the update run unattendedly or automatically:
For unattended update, use the following command line:
\<server_path>\setup\NWSAPSETUP.exe /UPDATE /silent

To update a specific package or product, add:
/package="package command-line name"
Or
/product="product command-line name"

You will find the command-line name of the package or product in the administrative console NWSAPSetupAdmin.exe.

For automatic update, you can use the SAP Automatic Workstation Update. Whenever the installation server is patched, or the packages installed are updated, this service will update the workstation(s) and reboot them if necessary. The workstation updater works in two modes - one in the presence of a logged-on user and another in his or her absence.

- When a user is logged on, the user is informed of update availability and the update happens on the user's assent. The user is also informed if a reboot is necessary and the reboot is also only executed on the user's assent.
- If no user is logged on, the update is done automatically and the reboot (if necessary) is done automatically, too.

The SAP Automatic Workstation Update is not SAP GUI-specific, it works with all components available on the installation server. For details, see section 3.9 Configuring SAP Automatic Workstation Update.

Result

Depending on the chosen update method, the front end is updated with or without user interaction. In case of a user-interactive update, the user just has to choose Next to start the front-end update.

5.2.2 Patching a Standalone Front End

You can update a standalone front end by running a patch on it. Updating involves the same steps as an installation.

More information: Installation of the SAP Front End [page 47]

We recommend updating with an installation server [page 54] instead of updating individual front ends by running a patch.

5.3 Upgrade of the SAP Front End

This section describes how to upgrade SAP GUI for Windows to a new major version.

5.3.1 Upgrading an Installation Server

To migrate an existing Front-End Installation server that is based on release 7.20 or newer to a newer compilation or release, proceed as follows:
1. Download the new compilation CD or DVD.
2. Create a copy of your existing installation server for fallback purposes.
3. Extract the downloaded CD or DVD to a folder of your choice.
4. In the extracted media, browse to the folder GUI\WINDOWS\WIN32\setup and start NwUpdateInstServer.exe from that folder.
5. On the first wizard page, choose Next on the first wizard page.
6. On the next wizard page, choose Browse, navigate to the shared folder of the Front-End Installation Server to be upgraded, select that folder and then confirm the browse dialog.
7. Choose Verify and then Next in case of a verification success.
   The upgrade starts now and the progress bar of the wizard informs you about the progress of the upgrade.
8. Start NwsapSetupAdmin.exe of the upgraded installation server and find your packages in the Packages tab. Mark your package with the right mouse button and choose Configure Properties. In the Configure Packages tab, click on the link Change Package Content. Some components of your old selection might be unselected because they were moved in the product hierarchy. Mark them as selected. Then save the package.
9. Test whether the new package updates existing clients successfully.

5.3.2 Upgrading a Standalone Front End
To upgrade a standalone version of SAP GUI for Windows to a new major release, follow the steps described in chapter 5.1.2 using the installation media of the desired target release.

6. Additional Information
The following sections are optional and provide additional information:
- Removing an Installation Server [page 56]
- Uninstalling the SAP Front End [page 57]
- FAQs [page 57]
- Viewing Log and Error Files [page 58]
- Command-Line Parameters [page 59]
- Component List [page 62]

6.1 Removing an Installation Server
**Use**
You can remove an installation server if it is no longer needed.

**Procedure**
1. If local security handling [page 43] is configured, start NWSAPSetupAdmin.exe and stop it using the Services menu.
2. First unshare the folder so that the installation server is not available to front ends on the network.

3. Delete the folder from the file system using the Windows explorer.

### 6.2 Uninstalling the SAP Front End

**Prerequisites**

Make sure that SAP GUI for Windows applications are not running at uninstall time. If an application is running during the uninstallation, the user is prompted to reboot afterwards.

**Procedure**

1. Choose Start → Settings → Control Panel → Add or Remove Programs.
   A list of the installed applications appears.
2. Select SAP GUI for Windows 740.
3. Choose Remove.
4. Choose Next.

**Result**

SAP GUI for Windows is uninstalled and a log file is generated.

Note: To ensure the upgrade possibility, the product name of the SAP GUI for Windows 7.40 is SAPGUI.

To perform silent, unattended uninstallation, enter the following commands:

- `NWSAPSetup.exe /Product="<product name>" /Silent /Uninstall` for uninstalling a certain product, for example SAPGUI.
- `NWSAPSetup.exe /all /Silent /Uninstall` for uninstalling all SAP components installed by SAPSetup without having to call specific command-lines for specific products.

You find more information on this in section 5.5 Command Line Parameters.

### 6.3 FAQs

You can find FAQs for the server and the client part of NetWeaver SAP Setup either from the DVD, from the installation directory, or in the system documentation of the NetWeaver SAPSetup Server Installation Administration Tool (`NWSAPSetup.exe`) choosing Help → SAP Installation Server Help.

The FAQs for the server can be found under SAP Installation Server Help → Troubleshooting and FAQs.

The FAQs for the client can be found under SAP Front-End Installer Help → Troubleshooting and FAQs.

### 6.4 Diagnosing Front-End Software Installations using NWCheckWorkstation
To diagnose a workstation containing installed SAP components, start \texttt{NWCheckWorkstation.exe} from either the \texttt{SETUP} directory of the Installation Server or from the \texttt{SETUP} directory of the workstation (\texttt{%PROGRAMFILES\%\SAP\SAPSetup\Setup}), and follow the wizard. You will be presented with a report on completion of the check process.

\texttt{NWCheckWorkstation} verifies the installation of SAP front-end components by checking for discrepancies in files, services, registry-keys, and other artifacts deployed using \texttt{NWSAPSetup}.

The workstation check tool will collect critical installation files and compress them into a cabinet archive. This \texttt{CAB}-File will be presented to the user after the completion of the process, and can be supplied to SAP support staff when reporting installation issues - for quicker diagnosis.

### 6.5 Repairing Front-End Software Installations using \texttt{NWSAPSetup}

To repair a workstation containing installed SAP components, start \texttt{NWSAPSetup.exe} from the \texttt{SETUP} directory of the Installation Server. \texttt{NWSAPSetup.exe} has to be called from the command line with \texttt{/repair}.

\texttt{NWSAPSetup /repair} checks for discrepancies in files, services, registry-keys, and other artifacts deployed using \texttt{NWSAPSetup} and repairs the installation of SAP front-end components based on the outcome of these checks.

\begin{itemize}
  \item Note that the repair process includes an update of all Front End components as described in chapter 4.2.1. If the version of a component on the installation server is higher than of the component installed on the workstation, then this component will be updated.
\end{itemize}

When the repair process starts, a progress screen appears. Processing is recorded in the following file: \texttt{%ProgramFiles\%\SAP\SAPSetup\Logs\NWSAPSetup.log}

If there are errors, you see a link to an \textit{Error Report}. Errors are recorded in the following file, which you can view using your normal web browser:

\texttt{%ProgramFiles\%\SAP\SAPSetup\Errors\SAPSetupErrors\_<DateTime>.xml}

If you have a problem, create a problem message on component BC-FES-INS and attach these files to the message.

When the repair process is complete, you see a confirmation screen. Your SAP front-end components are now successfully repaired and ready to use.

### 6.6 Viewing Log and Error Files

#### Log Files

All the installation tools described in this document maintain an activity record in log files that you can find here:

\texttt{%ProgramFiles\%\SAP\SAPSetup\Logs}

Each tool stores the last ten log files.

#### Error Files

Errors are stored in an XML format in files that you can view in any browser and you can find in the following folder:
%ProgramFiles%\SAP\SAPSetup\Errors

If you have a problem, create a problem message in BC-FES-INS and attach the relevant log files to the message.

**Log and Error Files for Each Tool**

<table>
<thead>
<tr>
<th>Tool</th>
<th>Log File</th>
<th>Error File</th>
</tr>
</thead>
<tbody>
<tr>
<td>NWCreateInstServer.exe</td>
<td>NWCreateInstServer.log</td>
<td>NwCreateInstServerErrors_&lt;DateTime&gt;.xml</td>
</tr>
<tr>
<td>NWUpdateInstServer.exe</td>
<td>NWUpdateInstServer.log</td>
<td>NwUpdateInstServerErrors_&lt;DateTime&gt;.xml</td>
</tr>
<tr>
<td>NWSAPSetupAdmin.exe</td>
<td>NwSAPSetupAdmin.log</td>
<td>NWSAPSetupAdminErrors_&lt;DateTime&gt;.xml</td>
</tr>
<tr>
<td>NWSAPSetup.exe</td>
<td>NWSAPSetup.log</td>
<td>SAPSetupErrors_&lt;DateTime&gt;.xml</td>
</tr>
</tbody>
</table>

**6.7 Command-Line Parameters**

In this section, you find two tables with command line parameters:

- for installation server creation and update
- for frontend installation and update

**Installation Server Creation and Update Command Line Parameters**

<table>
<thead>
<tr>
<th>NWCreateInstServer/ NWUpdateInstServer Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/Dest</td>
<td>Use this parameter to supply the destination folder where you wish to create your installation server. Sample: /Dest=&quot;C:\MyInstServerPath&quot;</td>
</tr>
</tbody>
</table>
| /noDlg                                          | Shows only the progress dialog Displays no other user interface. You can use it instead of /silent, if you wish to see progress.  

⚠️ If using /noDlg, you need to supply the destination server path via /Dest. |
| /silent                                         | Displays no user interface – not even progress  

⚠️ If using /silent, you need to supply the destination server path via /Dest. |
| /DontConfigureServerPath                       | Disables the automatic installation source folder configuration (network share creation and null-session accessibility). |
You can use command-line parameters to automatically replicate your (master) installation server across multiple locations.

### Front-End Installation and Update Command Line Parameters

You can call `NWSAPSetup.exe` with the command-line parameters listed below.

<table>
<thead>
<tr>
<th>NWSAPSetup Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/package: [&quot;&lt;package command-line name&gt;&quot;], [/silent], [/uninstall], [/update]</td>
<td>Displays the wizard that lets you choose packages</td>
</tr>
<tr>
<td></td>
<td>You <strong>cannot</strong> switch to <strong>Product View</strong>.</td>
</tr>
</tbody>
</table>
| /Product: ["<product command-line name>"], [/uninstall], [/silent], [/update] | ● If no product name is supplied, this command line parameter enables a view of available products and products that have already been installed.  
● If a product name is supplied, the installer displays information about the supplied product only. |
|                       | You **cannot** switch to **Package View**. |
| /ForceWindowsRestart  | Restarts the workstation automatically when the installation is done.  
Use in combination with package and product after /silent or /nodlg. |
|                       | **Example:** <installation source>\setup\nwsapsetup.exe /silent /product="SAPGUI" /ForceWindowsRestart |
| /noDlg                | Shows only the progress dialog  
Displays no other user interface. You can use it instead of /silent. |
|                       | **⚠️** If using /noDlg, you need to specify a product name or package name. |
| /silent               | Displays no user interface – not even progress |
|                       | **⚠️** If using /silent, you need to specify a product name or package name. |
| /SMS: ["<package command-line name>"], [/noDlg], [/silent], [/uninstall] | Creates a status file (Package Name.MIF) in the %TEMP% folder that indicates the success or failure of the package installation, or uninstallation.  
Typically used by software distribution systems |
such as SMS to determine the success or failure of a remote installation (advertised package installation).

```
/uninstall
```

Uninstalls components that belong to a specified product or a package.

This command-line parameter is valid only together with one of the following:

```
/Product="Product Command-Line Name"
.Package="Package Command-Line Name"
/all for uninstalling all SAP components installed by SAPSetup; works only when supplied with /nodlg or /silent
```

```
/update
```

Updates components present in a newer version on the installation server due to a patch.

To update a specific product or package, supply an additional parameter:

```
/Product="Product Command-Line Name"
or
.Package="Package Command-Line Name"
```

You can install multiple products using a single command with the + operator, as shown in the following examples:

```
\ServerName\ShareName\Setup\NwSAPSetup.exe
/Product="SAPGUI+SAPBI" /NoDlg
```

To uninstall multiple products, append the `/uninstall` command-line parameter.

**Product Command Line Names**

The following table lists the command line names of the products delivered on Presentation CD 1. These command line names can be used with `NwSapSetup.exe` in the command line when installing in product mode.

<table>
<thead>
<tr>
<th>Product</th>
<th>Command Line Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Netweaver Business Client 5.0</td>
<td>NWBC50</td>
</tr>
<tr>
<td>SAP GUI for Windows 7.40</td>
<td>SAPGUI</td>
</tr>
<tr>
<td>KW-Add-On for SAP GUI 7.40</td>
<td>KW</td>
</tr>
<tr>
<td>SAP Automatic Workstation Update</td>
<td>SAPWUS</td>
</tr>
<tr>
<td>Business Explorer</td>
<td>SapBI</td>
</tr>
<tr>
<td>i.s.h.med Planning Grid</td>
<td>GUIISHMED</td>
</tr>
<tr>
<td>SAP Jnet/Jgantt</td>
<td>Jnet</td>
</tr>
<tr>
<td>SAP GUI Screen Reader Extension for JAWS</td>
<td>SRX</td>
</tr>
<tr>
<td>SNC Client Encryption</td>
<td>SCE</td>
</tr>
</tbody>
</table>
If you have both SAP Secure Login Client (SLC) and SAP SNC Client Encryption (SCE) installed and want to uninstall only one of the two products, read note 2220853 before doing so.

<table>
<thead>
<tr>
<th>SAP Secure Login Client</th>
<th>SLC</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you have both SAP Secure Login Client (SLC) and SAP SNC Client Encryption (SCE) installed and want to uninstall only one of the two products, read note 2220853 before doing so.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Install SAP GUI Desktop Icon…</th>
<th>NWBCGUI</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Interactive Excel</td>
<td>AXL</td>
</tr>
</tbody>
</table>

### 6.8 Return Codes

If you start NwSapSetup.exe from a batch file, the return code can be caught by the %ErrorLevel% environment variable.

**Example:**

```bash
<Path to your installation source>\setup\NwSAPsetup.exe /package="<Name of your Installation package>" /silent
```

The following table gives an overview of the return codes for NwSapSetup.exe and their descriptions:

<table>
<thead>
<tr>
<th>Return Codes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Process ended without any errors detected.</td>
</tr>
<tr>
<td>48</td>
<td>General Failure</td>
</tr>
<tr>
<td>67</td>
<td>Installation is canceled by the user.</td>
</tr>
<tr>
<td>68</td>
<td>Invalid patch</td>
</tr>
<tr>
<td>69</td>
<td>Installation engine registration failed.</td>
</tr>
<tr>
<td>70</td>
<td>Invalid XML Files</td>
</tr>
<tr>
<td>129</td>
<td>Reboot is recommended.</td>
</tr>
<tr>
<td>130</td>
<td>Reboot was forced.</td>
</tr>
<tr>
<td>144</td>
<td>Error report has been created.</td>
</tr>
<tr>
<td>145</td>
<td>Error report has been created and reboot is recommended.</td>
</tr>
<tr>
<td>146</td>
<td>Error report has been created and reboot is forced.</td>
</tr>
</tbody>
</table>
In case of return codes 144-146, have a look at the error and log file for NwSapSetup.exe as described in section Viewing Log and Error Files.

6.9 Component List

The component list describes the features and functions of the selectable components, and the prerequisites for using them. The components are grouped under component groups.

List of Component Groups

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver Business Client</td>
<td>Installs the SAP NetWeaver Business Client. &lt;br&gt;When installing SAP GUI together with the SAP NWBC, the system connection data are distributed and stored in a different way than in former versions of the two clients. For details, see Configuration Information. &lt;br&gt;In addition, when choosing this component on install, no SAP Logon (Pad) Desktop Icon is displayed and no shortcuts are registered to SAP Logon until you choose the component Install SAP GUI Desktop Icon/Shortcuts even though NWBC is installed (see description below).</td>
</tr>
<tr>
<td>SAP GUI Suite</td>
<td>SAP GUI for Windows along with all essential sub-components</td>
</tr>
<tr>
<td>Install SAP GUI Desktop Icon / Shortcuts even though NWBC is installed</td>
<td>When SAP GUI for Windows is installed together with NWBC, by default, SAP GUI and SAP GUI Shortcuts will be launched through NWBC. However, when you would still like to use SAP GUI and NWBC in parallel, you can select this component to install the SAP Logon (Pad) Desktop Icon and to register SAP GUI shortcuts to SAP Logon.</td>
</tr>
<tr>
<td>R/3 Add-On</td>
<td>Front-end add-on for SAP R/3 Enterprise &lt;br&gt;This package contains application extensions that are needed for some R/3 transactions.</td>
</tr>
<tr>
<td>General Add-On</td>
<td>Front-end add-on that can be used to extend functionality of SAP systems and that are not restricted to one SAP Component</td>
</tr>
<tr>
<td>Legacy Components</td>
<td>Components for the usage with older SAP releases (SAP R/3 4.6 and lower) or old Office products (Excel 95, ...). &lt;br&gt;These components will only be needed if you intend to use this version of SAP GUI for Windows with your old SAP installations.</td>
</tr>
<tr>
<td>CRM Add-On</td>
<td>Front-end add-on for SAP Customer Relationship Management (CRM)</td>
</tr>
<tr>
<td>KW Add-On</td>
<td>Front-end add-on for SAP Knowledge Workhouse. This package contains components to create, edit, translate and display content.</td>
</tr>
<tr>
<td>SCM Add-On</td>
<td>Front-end add-on for SAP Supply Chain Management (SCM)</td>
</tr>
<tr>
<td>SEM Add-On</td>
<td>Front-end add-on for SAP Strategic Enterprise Management (SEM)</td>
</tr>
</tbody>
</table>
### i.s.h.med Planning Grid

The i.s.h.med Planning Grid is the graphics-based tool for planning appointments in the clinical system i.s.h.med. This component contains the current planning grid version as of SAP ECC 6.0, Industry Extension Healthcare, Enhancement Package 4. Its installation requires the Java Runtime Environment to be installed on the machine. For more information, see [SAP note 1013957](https://apo.sap.com/notes1013957.htm) and the i.s.h.med Homepage [www.ishmed.com](http://www.ishmed.com) where you can also download planning grid versions of earlier Releases.

### SAP JNet/JGantt

Jnet/JGantt is an editor for network graphics that can be used by any application to integrate different forms of graphic representations.

This component requires a Java Runtime Environment to be installed on the client machine.

- As of Java release 8 (1.8), the AxBridge is no longer supported by Java, so that the implementation of the embedding of JNet/JGantt in SAP GUI for Windows had to be changed. With Java 8, the HTML-Control is used which is part of the SAP GUI and in which JNet/JGantt are instantiated as Java applets. For details and restrictions, see [note 2103687](https://apo.sap.com/notes2103687.htm).

### SAP Screenreader Extensions (SRX)

SAP GUI Screen Reader Extensions (SRX) enable the use of SAP GUI together with the screen reader program Jaws for Windows. The Extensions are Jaws-based scripts that make the SAP GUI accessible via the SAP GUI object model.

The prerequisites for SRX are as follows:

- Freedom Scientific JAWS is installed in a supported version (see also [note 755545](https://apo.sap.com/notes755545.htm))
- SAP GUI is installed or will be installed

### SAP Automatic Workstation Update

The automatic workstation update service is a new installer feature shipped as of 7.20 compilation 2. It works only when installed on the workstation. Whenever the installation server is patched, or the packages installed are updated, this service will update the workstation(s) and reboot them if necessary. The workstation updater works in two modes - one in the presence of a logged-on user and another in his absence:

- When a user is logged on, the user is informed of update availability and the update happens on the user's assent. The user is also informed if a reboot is necessary and the reboot is also only executed on the user's assent.
- If no user is logged on, the update is done automatically and the reboot (if necessary) is done automatically, too.

### SNC Client Encryption

SNC Client Encryption is an optional feature of SAP GUI and SAP NetWeaver technology platform. It enables users to protect communication between SAP GUI for Windows and SAP NetWeaver Application Server (AS) ABAP. The component also enables encryption for RFC clients, such as BEx Query Designer.
Business Explorer

The Business Explorer is the SAP Business Information Warehouse component that provides flexible reporting and analysis tools for strategic analyses and decision-making support within a company. These tools include query, reporting, and analysis functions.

You can perform a local installation of the Business Explorer by running `SAPBISetup.exe` from the `PRES1\GUI\WINDOWS\WIN32` subfolder of the SAP NetWeaver Presentation DVD. You can also import “Business Explorer” to an installation server and define your own packages to include this product.

The Business Explorer tree node also contains the OLE DB for OLAP clients to connect to SAP NetWeaver Business Intelligence (BI).

---

**Discontinued Products**

Discontinued as of SAP GUI for Windows Release 7.40:

- **ECL Viewer**
  
  For more information, see [note 2155818](#).

- **Controls for the SAPscript Legacy Editor**
  
  For more information, see [note 2155818](#).

- **FI-LC: Remote Data Entry and EC-CS: Remote Data Entry**
  
  For more information, see [note 169887](#).

- **Standard Regression Testing (START)**
  
  For more information, see [note 2045115](#).

Discontinued as of SAP GUI for Windows Release 7.30:

- **BW 3.5 Add-On:**
  
  For details, see [SAP notes 1652771 and 1652772](#).

- **SAPPhone Server:**
  
  For more information see [SAP note 171201](#).

- **PS:Export Interfaces:**
  
  The component PS: Export Interfaces is not delivered anymore with SAP GUI.

- **Balanced scorecard and Sales Planning:**
  
  For more information, see [SAP note 1665318](#).

---

**List of Available Components**

**SAP GUI Suite**

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP GUI</td>
<td>SAP graphical front end with starter application SAP Logon Pad The user can only display preconfigured connection information for SAP systems provided by the administrator (see documentation for details).</td>
</tr>
<tr>
<td>SAP Logon Pad</td>
<td>Desktop and Start menu shortcuts for SAP Logon Pad</td>
</tr>
</tbody>
</table>
The functionality of SAP Logon Pad is fully contained in SAP Logon. Therefore these shortcuts are **only** created if SAP Logon is not selected.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Logon</td>
<td>Extended starter application SAP Logon with desktop and <em>Start</em> menu shortcuts. The user can display and modify connection information for SAP systems.</td>
</tr>
<tr>
<td>SAP GUI Scripting</td>
<td>SAP GUI scripting interface. <strong>More information:</strong> <a href="#">SAP_GUI_Scripting_API.pdf</a> from the PRES1/DOCU folder on the <em>SAP NetWeaver Presentation DVD</em>.</td>
</tr>
<tr>
<td>GUI XT</td>
<td>SAP GUI extensions for client side customizing of SAP Dynpro screens</td>
</tr>
<tr>
<td>Unicode RFC Libraries</td>
<td>Unicode RFC libraries for software developers. Supports Unicode and non-Unicode communication partners. Accessible from Visual Basic through COM Interface</td>
</tr>
</tbody>
</table>

### R/3 Add-On

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interactive Excel</td>
<td>Module FI or EC: Add-on to Microsoft Excel for creating reports in Microsoft Excel using data from FI-LC or EC-CS consolidation. Excel sheets can be filled with data from the SAP system or the Remote Data Entry tools for FI-LC and EC-CS. It can be used for data entry into the FI-LC or EC-CS Remote Data Entry tool. Requires Microsoft Excel 97.</td>
</tr>
<tr>
<td>SAP 3D Visual Enterprise Viewer 8.0 SP3 MP1</td>
<td>Visual Enterprise Viewer (VEV) is a free 3D visualisation viewer for Windows. VEV allows collaboration, analytics, as well as assembly and maintenance work instructions to be delivered in interactive real-time 3D.</td>
</tr>
<tr>
<td>PD: Microsoft Excel Link</td>
<td>Module PT/ Shift Planning. Allows you to display the SAP duty roster data with Microsoft Excel. Requires Microsoft Excel.</td>
</tr>
<tr>
<td>EH&amp;S WWI</td>
<td>Module EH&amp;S: Windows Word Processor Integration. Report tool for SAP PLM Environment, Health and Safety to generate reports such as material safety data sheets and labels. RTF Viewer required</td>
</tr>
</tbody>
</table>

### General Add-On

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar Synchronization for Microsoft Outlook</td>
<td>Outlook client extension for the synchronization of SAPoffice calendar with the Outlook calendar.</td>
</tr>
</tbody>
</table>
The prerequisites for using the calendar synchronization are as follows:

- MS Office 2007 oder 2010 (32bit)
- Windows Vista, Windows 7, or Windows Server 2008
- In addition, Microsoft Visual Studio Tools for the Microsoft Office system (VSTO) 3.0 SP 1 must be installed on the computer. VSTO 3.0 SP1 can be downloaded via the following links:

### Graphical Distribution Network

Display and maintenance of a distribution network inside a corporation

The components SAPphone Server and SAPphone Call Status Control have been removed from SAP GUI for Windows as of 7.30.

More information: [SAP note 171201](https://support.sap.com/)

The component SAP (WEB) Console is not part of the delivery as of SAP GUI for Windows 7.20.

More information: [SAP note 1017827](https://support.sap.com/)

Microsoft Outlook Integration is no longer supported and therefore has been removed from the SAP NetWeaver Presentation DVD.

More information: [SAP note 627397](https://support.sap.com/)

### Legacy Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Word Link via RFC</td>
<td>Installation of Word connection for SAP R/3 3.x, and 4.0B Requires Microsoft Word 6, 95, 97, or 2000</td>
</tr>
<tr>
<td>Report Writer: Microsoft Excel Link</td>
<td>Import filter for Microsoft Excel: converts a file exported by Report Writer in Excel format (RPW format) into an Excel spreadsheet Works with Excel 95, 97, or 2000</td>
</tr>
<tr>
<td></td>
<td>Used with SAP System Releases 3.1 to 4.5 only.</td>
</tr>
</tbody>
</table>

XXL List Viewer is no longer available on the SAP NetWeaver Presentation DVD.

More information: [SAP note 526579](https://support.sap.com/)

### Business Explorer
### SAP Help
**14.04.2016**

### SAP Front End Installation Guide

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Explorer with OLE DB for OLAP Provider</td>
<td>The Business Explorer is the SAP Business Information Warehouse component that provides flexible reporting and analysis tools for strategic analyses and decision-making support within a company. These tools include query, reporting, and analysis functions. The Business Explorer tree node also contains the OLE DB for OLAP clients to connect to SAP NetWeaver Business Intelligence (BI).</td>
</tr>
</tbody>
</table>

### CRM Add-On

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRM Front End</td>
<td>Front-end add-on of SAP Customer Relationship Management (CRM)</td>
</tr>
</tbody>
</table>

### KW Add-On

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>KW Knowledge Workbench</td>
<td>Authoring tool to easily maintain SAP documentation and SAP training Requires Microsoft Internet Explorer 5 or higher</td>
</tr>
<tr>
<td>KW Online Editing</td>
<td>Knowledge Warehouse Editing within SAP GUI Requires Microsoft Internet Explorer 5 or higher</td>
</tr>
<tr>
<td>KW Translator</td>
<td>Knowledge Warehouse Translator: Translation tool to process translation packages offline Requires Microsoft Internet Explorer 5 or higher</td>
</tr>
<tr>
<td>KW Viewer</td>
<td>Viewing tool to display training courses offline</td>
</tr>
<tr>
<td>KW HTML Editor</td>
<td>Allows creating and editing HTML documents in SAP GUI for area HTML-Based Documents. This is an alternative to the old component Html Pad which allows creating and editing HTML documents within Knowledge Workbench (KWB)</td>
</tr>
</tbody>
</table>

### SAP NetWeaver Business Client

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NWBC</td>
<td>User interface (UI) that presents a single entry point to different SAP business applications and technologies. It is a high-fidelity shell that integrates various UI technologies and design generations aimed at a more efficient, intuitive, and complete user experience over different UI technologies. You find more information on the <a href="#">NWBC SCN page</a>.</td>
</tr>
</tbody>
</table>

### SAP i.s.h.med Add-On

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>i.s.h.med Planning Grid</td>
<td>The i.s.h.med Planning Grid is the graphics-based tool for planning appointments in the clinical system i.s.h.med. This component contains the current planning grid version as of SAP ECC 6.0, Industry Extension Healthcare, Enhancement Package 4. Its installation</td>
</tr>
</tbody>
</table>
requires the Java Runtime Environment to be installed on the machine. For more information, see SAP note 1013957 and the i.s.h.med Homepage www.ishmed.com where you can also download planning grid versions of earlier Releases.

SCM Add-On

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCM Front End</td>
<td>Front-end add-on of SAP Supply Chain Management (SCM)</td>
</tr>
</tbody>
</table>

SEM Add-On

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphical Assignment</td>
<td>Graphical assignment tool</td>
</tr>
</tbody>
</table>

SNC Client Encryption

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNC Client Encryption</td>
<td>Is an optional feature of SAP GUI and SAP NetWeaver technology platform. It enables users to protect communication between SAP GUI for Windows and SAP NetWeaver Application Server (AS) ABAP. The component also enables encryption for RFC clients, such as BEx Query Designer.</td>
</tr>
</tbody>
</table>
6.10 SAP UI Landscape XML Description

This chapter describes the SAP UI Landscape XML format. This file format has to be used in the SAP GUI Configuration with SAP NetWeaver Business Client. Otherwise, it is optional.

The following picture shows the basic elements of the xml file:

```xml
<?xml version="1.0" encoding="UTF-8" ?>
<landscape>
  <messageservers>
    <messageserver uid="3b764a2e-edba-493e-a470-2ad33b5f4479" name="MS1" host="ms1server.mycompany.com" port="1234" />
  </messageservers>
  <messageheaders>
    <messageheader uid="0f80d55a4e-04cb-4534-0c44-2e5ebc39f30" name="MS2" host="ms2server.mycompany.com" port="2345" />
  </messageheaders>
  <routes>
    <router uid="c633f9a6-47f8-4a5b-8632-359cb9465df" name="MyCorp Router"
      route="https://sapgateway.mycompany.com/5/3456/m" />
  </routes>
  <services>
    <service uuid="0fe14e42-b109-4083-0013-9ad4e59ab02a" name="AB1 [PUBLIC]"
      systemid="3b79f42d-08da-493e-8700-2ad33b5f4479"
      type="SAPGUI">
      description="AB1 [PUBLIC]"
      slow_connection="0"
      sapccp="1100"
      dscp="2"
      ptree="AB1"
      scope="0"/>
    <service uuid="440e6b50-18e7-4f0c-9e6e-8333b9f2098"
      name="CD2 [PUBLIC]"
      systemid="4df524a-4d6-4534-8c44-2e5ebc39f30"
      type="SAPGUI">
      description="CD2 [PUBLIC]"
      slow_connection="0"
      sapccp="1100"
      dscp="2"
      ptree="CD2"
      scope="0"/>
    <service uuid="3f0e26ad-7c75-4667-b0c3-2a9e0eb01624"
      name="CD2 [PUBLIC]"
      systemid="4df524a-4d6-4534-8c44-2e5ebc39f30"
      type="SAPGUI">
      description="CD2 [PUBLIC]"
      slow_connection="0"
      sapccp="1100"
      dscp="2"
      ptree="CD2"
      scope="0"/>
    <service uuid="0d4a4b2e-f9f9-4d34-bbdf-0023a0b06c4" name="Search SAP" type="SAPUI">
      description="Search SAP"
      url="http://www.sap.com/search/">
      <services>
        <workspace uuid="8c4baf8-4b48-4034-8460-4242b26f7f6" name="Information Developers' Workspace" expanded="1" hidden="0">
          <node uuid="2ad887a-0093-471d-8b00-203b29e83963" name="Online Documentation backends" description="Store your online documentation in this Backend">
            <item uuid="e05d4a8-2d74-448f-87b0-4b9c83b6c69" name="SAP GUI:">
            <item uuid="10c091a-592c-4b4f-83ac-265ac1313131" name="SAP ABAP"/>
            <item uuid="5c6971a-0be-4394-4660-8f20a319d66d" name="SAPUI">
                <parameters name="StatusUrl" value="https://iserver80.mycompany.com/systemstatus.php"/>
            </item>
          </node>
        </workspace>
      </services>
    </service>
  </services>
</landscape>
```

The file consists of the following basic elements:

1. Specification of the encoding at the top
   Index=0 is reserved for usage by SAP. All other indices can be used freely to determine the order in which includes are processed when loading the landscape document.

2. Definition of the message servers available in the current system landscape with `uid`, `name`, `host` and `port`.
   You find the resources to generate uids in the internet.

   This message server list should contain at least the message server definitions used in the `<services>` section described below. Instead of defining the message servers here, you can also refer to them and other data via includes (see bullet 6 below).

3. Definition of the routers with `uid`, `name` and complete `router` string

4. Definition of services
   This is a flat, non-hierarchical list of all services referred to from within `Workspaces`. The list may contain also services not referred to that are used on client side for creating user workspaces or for building other functionality such as favorite list or search provider list.
Generally, a service entry consists of \textit{uuid}, \textit{name} and \textit{type} (=service type, for example SAP GUI connection, SAP GUI shortcut, NWBC connection to WebAS ABAP or Portal, or search provider used by NWBC).

Depending on the service type, you specify additional attributes:

- For SAP GUI connections, the service entry contains message server \textit{uuid}, \textit{system id}, \textit{server} (group or hostname:port), SNC and codepage entries. You can set the following SNC entries: with \textit{sncop}, you define, if single-sign-on is disabled (disabled = 0), and with \textit{snuname} the SNC name is defined, for example \textit{p/secude:CN=ACM, 0=ACME, C=DE}.

Concerning the encoding, you have the following possibilities: With \textit{sapcpg}, the SAP Codepage can be selected, for example 0,1,2,11000 etc. And with \textit{dcpg}, the Sap Code page for upload and download is defined, example values: 0,1,2,1100 etc.

- For NWBC connections to WebAS ABAP backends, the service entry must contain the connection URL. Message server \textit{uuid}, system \textit{id}, \textit{server}, \textit{client}, language, and \textit{uuid} of a referenced SAP GUI connection are optional.

- For NWBC connections to Portal backends, the service entry must contain the connection URL.

- In search provider service entries, the search url (according to SAP NetWeaver Business Client End User Guide, chapter "Search Types") is defined, mnemonics are optional.

5. Definition of workspaces and its nodes and items

A workspace is a group of connections for certain users, for example, for information developers. It consists of a group of services (items) and folders (nodes) and can be used to show some predefined service set in UI or to do multi-logon for all services in the workspace. The workspace is so-to-speak a special kind of top node.

The nodes (folders) are item grouping elements of the workspace. They are used to organize the items (=services) within the workspace. From nodes and items, tree structures can be built. Items are placeholders for services and the data is taken from the service description. You can define items directly in the workspace or in a node.

A workspace is defined with \textit{uuid}, \textit{name}, \textit{expanded} (= state of the folder in UI: open or closed; the default is true), \textit{hidden} (=marks the workspace as hidden and invisible in the UI).

A node is defined with \textit{uuid}, \textit{name}, \textit{description}, \textit{expanded} (= state of the folder in UI: open or closed; the default is true), \textit{hidden} (=marks the node as hidden and invisible in the UI and allows changing workspace configuration locally).

An item is defined with \textit{uuid}, \textit{serviceID} (id of the service the items refers to; it should be one of the known services from the service repository), \textit{hidden} (marks item as hidden and invisible in the UI and allows changing the workspace configuration locally).

6. Insertion of includes

An include is a file or URL containing information that you want to merge with the content in your XML. This means, for example, that you do not need to define message servers directly in this XML file, but that you can point to this information from within the includes section. An include node describes a single source to include and can have the following attributes: \textit{URL}, \textit{index} (shows which include is loaded first), \textit{name}, \textit{description}.

7. System check via configuration

Note that this feature is only supported with SAP Logon (Pad) in SAP GUI for Windows.
The *Configuration* repository contains a list of parameters related to the system landscape. It has no own attributes. With the data under *Configuration* the server status can be checked. Currently, two parameter keys are supported: *SystemStatusURL* and *SingleSystemStatusURL*. In case no connection can be established to the backend/server, the system status can still be checked via these two web sites. The first parameter holds a generic status page URL, the second a query URL that contains a %s parameter which is replaced with a specific systemid.

⚠️ General notes

You can insert regular XML comments.

If a section remains empty, for example the `<Routers>` section, it has no effect.

🔍

On the [SAP GUI Family page on SCN](https://scn.sap.com), you can find a pdf file with SAP UI Landscape Best Practices for Administrators. The document describes common usage scenarios of SAP UI Landscape.